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特性 

 支持用户定义的按键、滑条、触摸板和接近电容传感器的各种组合。 

 支持 SmartSense™自动调试或通过集成式 PC GUI 进行手动调试 

 对交流电力线噪音、EMC 噪音和电源电压波动有较强的抗干扰能力 

 支持屏蔽电极，保证传感器上存在水膜或水滴的情况下可靠工作 

 使用 CapSense 定制器设置传感器和终端的分配 

概述 

电容式感应使用 Delta-Sigma 调制器 (CapSense CSD) 组件，能够有效的测量触摸感应按键、滑

条、触摸板和接近检测等应用中传感器感应电容的微小变化。 

请阅读随附本数据手册的文档。具体情况请参见赛普拉斯半导体公司网址 www.cypress.com： 

 PSoC 4 CapSense 设计指南 

 Capsense 入门手册 

何时使用 CapSense 组件 

电容式感应系统可用于多种应用中，以代替传统按键、开关和其它控件，甚至可用于淋雨或潮湿

的工作环境的应用中。这些应用包括汽车、室外设备、ATM 机、公共接入系统、手机和 PDA 等便

携式设备以及厨房和浴室应用。 

输入/输出接口 

 N/A 

PSoC 4 电容式感应（CapSense® CSD） 
2.0 

http://www.cypress.com/
http://www.cypress.com/go/psoc4_capsense_designguide
http://www.cypress.com/?rID=48787
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组件参数 

将 CapSense CSD 组件拖放到您的设计中，然后双击打开 Configure（配置）对话框。该对话框

有若干选项卡，可引导您完成对 CapSense CSD 组件的配置过程。 

General 选项卡 

 

Load Settings/Save Settings（加载设置/保存设置 ） 

Save Settings 用于保存组件中所有当前配置和调试数据。这样，在新项目中就能够快速复制已保

存设置到新的模块。Load Settings 用于加载以前保存的设置。 

被保存的组件配置和调试数据可以导入调谐器 GUI。 
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Tuning method （调试方法） 

此参数指定了调试方法。调试操作包括选择具体硬件配置的最佳参数。 

其中有三个选项： 

 Auto（SmartSense） — 在支持的寄生电容（Cp）范围内（即从 5 pF 到 55 pF）对

CapSense CSD 组件进行自动调试。 

它是我们对所有设计推荐的调试方法。运行时，固件算法不断地确定最佳的调试参数。在

该模式下，需要额外的 RAM 和 CPU 资源。如果需要特定调试（严格控制扫描时间或 Cp

过高），请将 Tuning method 参数设置为“Manual with Run-Time Tuning”或

“Manual”。 

注意：可使用 I2C 通信进行 SmartSense 调校， 该组件在 Tuner Helper（调谐器助手）选

项卡中指定用于将目标器件中的数据传输到调谐器 GUI。 

 Manual with Run-Time Tuning （运行时手动调试） — 允许您在运行时间中使用调谐器

GUI 手动调试 CapSense CSD 组件。 通过调谐器 GUI 或使用 API 修改调试参数，可以实

现运行时调试操作。 

要启动 GUI， 请右击符号， 然后选择 Launch Tuner（启动调谐器）。有关手动调试的更

多信息， 请参阅本数据手册中的调谐器 GUI 用户指南 一节。手动调式需要 I2C 通信，该通

信在 Tuner Helper （调谐器助手）选项卡中指定用于在目标器件和调谐器 GUI 之间传输

数据。 

 Manual（手动） — 禁止调试。  

设置为 Manual 项（禁止运行时调试）时不允许组件的运行时调试，并且所有可能调试参

数被保存在 Flash 内。 

阈值模式 

当 Tuning method 参数被设置为“Auto（SmartSense）”时，通过该参数可以指定阈值模式。

选中任何手动调试选项时，该参数不可用。 

有两个选项： 

 Automatic（default）为默认选项。在该模式下，SmartSense 算法会自动计算并设置所有

传感器阈值。 

 Flexible — 由组件实现的灵活阈值。在该模式下，组件接受每个 Widget 的“手指阈值”，

然后根据手指阈值计算出其它阈值参数： 

□ lowBaselineReset = 30 

□ 迟滞 = 手指阈值的 12.5 % 
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□ 噪声阈值 = 手指阈值的 50% 

□ 负噪声阈值 = 手指阈值的 50% 

Raw Data Noise Filter（原始数据噪声滤波器） 

该参数用于选择原始数据滤波器类型。只能选择一个滤波器，且该滤波器将应用于所有传感器。

在传感器扫描期间，用户应使用滤波器来降低噪声的影响。有关滤波器类型的详情，请参见本文

档中功能说明一节的滤波器部分。 

 None（无） — 不使用滤波器。没有滤波器固件和 SRAM 的开销。 

 Median （中值滤波） — 按顺序排列最近三个传感器值，并返回中值。 

 Averaging （均值滤波） — 返回最近三个传感器值的简单均值 

 First Order IIR 1/2 （一阶 IIR 1/2 滤波） — 返回前一滤波器值的 1/2 与最近传感器值的

1/2 的和。在所有滤波器类型中 IIR 滤波器占用最少的固件和 SRAM 开销。 

 First Order IIR 1/4 （一阶 IIR 1/4 滤波）（默认） — 返回前一滤波器值的 3/4 与最近传感

器值的 1/4 的和。 

 First Order IIR 1/8 （一阶 IIR 1/8 滤波） — 返回前一滤波器值的 7/8 与最近传感器值的

1/8 的和。 

 First Order IIR 1/16 （一阶 IIR 1/16 滤波） — 返回前一滤波器值的 15/16 与最近传感器值

的 1/16 的和。 

 Jitter（抖动滤波） — 如果最近传感器值大于上一传感器值，那么先前的滤波器值按 1 递

增，如果小于上一传感器值，则递减。 

补偿 IDAC 

该参数用于使能基准线 IDAC。使能基准线 IDAC 能够提高灵敏度和信噪比（SNR）。在

CapSense 操作期间，补偿 IDAC 一直被连接到 amuxbus 上，用于补偿传感器的寄生电容。  

 Disabled（default）（禁用 — 默认选择） 

 Enabled（使能）  

Auto-calibration（自动校准）选框 

使能或禁用 IDAC 的自动校准功能。 
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Water proofing and detection（防水及检测） 

该特性用于配置 CapSense CSD，使其支持防水功能（默认为禁用）。该功能将使能屏蔽电极。

其设置参数如下： 

 使能屏蔽电极输出端 

注意：不应该在 SmartSense 调试模式下使用屏蔽电极。 

 添加保护传感器（Guard Widget） 

注意 ：如果保护 Widget 不需要防水性能，可以在 Advanced （高级） 选项卡上禁用它。 

使能 BIST 

该参数用于使能允许测量 Cp 和 Cmod 的 Built In Self Test（内置自测试）API。 

 

Widget Config 选项卡 

 

有关各种参数的定义， 请参见 功能说明一节中的内容。 
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工具栏 

工具栏包含以下指令： 

 Add widget （添加 Widget）（热键 — Insert）— 向列表中添加选定的 Widget 类型。

Widget 类型包括：  

□ Buttons（按键） — 按键可以检测到单个传感器上存在手指触摸，并替换了机械按

键。 

□ Linear Sliders（线性滑条） — 线性滑条提供一个关于手指触摸位置整数值，该值

是通过对若干个传感器上的信号进行插值的方法得到的。 

□ Radial Sliders（辐射滑条） — 辐射滑条类似于线性滑条，不同之处是传感器置于

一个圆圈中。 

□ Matrix Buttons（矩阵按键） — 矩阵按键检测行传感器和列传感器形成的交叉点处

存在的手指触摸。矩阵按键提供了一种扫描大量按键的有效方法。 

□ Touchpads（触摸板） — 触摸板返回触摸板区域内手指触摸的 X 和 Y 坐标。触摸

板由多个行传感器和列传感器组成。 

□ Proximity Sensors（接近传感器） — 接近传感器经过优化，可在离传感器很远的

距离检测是否存在手指、手掌或其它大物体。这样会不需要实际触摸。 

□ Generic Sensors（通用传感器） — 通用传感器提供了来自单个传感器的原始计数

（raw counts）。这样用户可以创建特殊或高级传感器，但是不能得到其它传感器类

型的经过处理的输出。 

 Remove widget （删除 Widget）（热键 — Delete） — 从列表中删除所选的 Widget。 

 Rename （重命名）（热键 — F2） — 打开一个对话框，更改选定的 Widget 名称。也可

以双击 Widget，以打开该对话框。 
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Buttons（按键） 

 

 

Tuning（调试）： 

 Finger Threshold（手指阈值） — 定义增大或减少触摸灵敏度的传感器活动阈值。当传感

器扫描值大于该阈值时，该按键被报告为“有触摸”状态。默认值为 100。8 位分辨率

widget 的有效值范围是[1…255]，16 位分辨率 widget 的有效值范围是[1...65535]。8 位分

辨率 widget 的 Finger Threshold + Hysteresis 的值不能大于 254，16 位分辨率 widget 的

值不能大于 65534。 

 Noise Threshold（噪声阈值） — 定义传感器噪声阈值。如果计数值高于该阈值，则不更

新基准线。如果噪声阈值过低，传感器和热偏移可能被忽略不计。这样会导致触摸错误或

触摸遗漏。如果噪声阈值过高，手指触摸可能会被解释为噪声，人为使基准线错误的升

高，从而导致手指触摸遗漏。默认值为 20。8 位分辨率 widget 的有效值范围是[1…255]，

16 位分辨率 widget 的有效值范围是[1...65535]。 

 Hysteresis（迟滞）— 添加传感器活动状态转换的差分迟滞。如果传感器处于非活动状

态，则差值计数必须大于手指阈值与迟滞的和才被认为是有效的状态转换条件。如果传感

器处于活动状态，则差值计数必须低于手指阈值与迟滞的差才被认为是有效的状态转换条

件。迟滞有助于确保低振幅传感器噪声和手指少量移动不会导致按键状态的循环。默认值

为 10。8 位分辨率 widget 的有效值范围是[1…255]，16 位分辨率 widget 的有效值范围是

[1...65535]。8 位分辨率 widget 的 Finger Threshold + Hysteresis 值不能大于 254，16

位分辨率 widget 的值不能大于 65534。 

 Debounce（去抖动）— 添加一个去抖动计数器来检测传感器活动状态转换。为了让传感

器能够从未激活状态切换为激活状态，在规定的样本数量内，差异计数值必须大于手指阈

值与迟滞之和。默认值为 5。Debounce（去抖动）确保高频率高振幅的噪声不会导致对按

键的误检。取值范围为[1…255]。 
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 Scan Resolution（扫描分辨率） — 定义扫描分辨率。该参数会影响按键 Widget 传感器

的扫描时间。N 位的扫描分瓣率最大原始计数为 2N – 1。提高分辨率可提高触摸检测的灵敏

度和信噪比（SNR），但会延长扫描时间。默认值为 10 位。取值范围为[6…16]。 

注意：这些参数不适用于 SmartSense 模式并由 SmartSense 算法自动设置。 

 

Linear Sliders（线性滑条） 

 

 

General（通用）： 

 Numbers of Sensor Elements（传感器元件数量） — 定义滑条内的元件数量。一个良好

的 API 分辨率与传感器元件数的比例是 20:1。过多增大该比例会造成计算的手指位置处噪

声增加。取值范围为[2…32]。默认值为 5 个元件。 

 API Resolution（API 分瓣率） — 定义滑条分辨率。位置值将在此范围以内变化。取值范

围为[1…255]。 
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 Diplexing – Non diplexed（双工 – 非双工）（默认）或 Diplexed（双工）。双工模式允

许两个滑条传感器共享一个器件引脚，从而减少了给定数量的滑条传感器所需的引脚总

数。 
P
S
o
C

Normal Linear Slider Diplexed Linear Slider

P
S
o
C

 

 Position Noise Filter（位置噪声滤波器） — 选择噪声滤波器类型以进行位置计算。对于

一个选定的 Widget，仅可应用一个滤波器。有关滤波器类型的详情，请参见本文档中功能

说明一节的滤波器部分。 

□ None（无） 

□ Median（中值滤波）  

□ Averaging（均值滤波）  

□ First Order IIR 1/2（一阶 IIR 1/2 滤波） 

□ First Order IIR 1/4（一阶 IIR 1/4 滤波，默认） 

□ Jitter（抖动滤波）  

Tuning（调试）： 

 Finger Threshold（手指阈值） — 定义增大或减少触摸灵敏度的传感器活动阈值。当传感

器扫描值大于该阈值时，该按键被报告为“有触摸”状态。默认值为 100。8 位分辨率

widget 的有效值范围是[1…255]，16 位分辨率 widget 的有效值范围是[1..65535]。 

 Noise Threshold（噪声阈值）— 定义滑条元素的传感器噪声阈值。如果计数值高于该阈

值，则不更新基准线。如果噪声阈值过低，传感器和热偏移可能被忽略不计。这样会导致

触摸错误或触摸遗漏。如果噪声阈值过高，手指触摸可能会被解释为噪声，且认为增加基

准线，导致中心位置计算错误。中心计算中不包括低于该阈值的计数值。默认值为 20。8

位分辨率 widget 的有效值范围是 [1…255]，16 位分辨率 widget 的有效值范围是

[1...65535]。 
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 Scan Resolution（扫描分辨率）— 用于定义扫描分辨率。该参数对线性滑条 Widget 内所

有传感器的扫描时间会产生影响。N 位的扫描分瓣率的最大原始计数为 2N – 1。 提高分辨

率可提高触摸检测的灵敏度和信噪比，但会增延长描时间。默认值为 10 位。取值范围为

[6…16]。 

注意：这些参数不适用于 SmartSense 模式并由 SmartSense 算法自动设置。 

Radial Slider（辐射滑条） 

 

 

General（通用）： 

 Numbers of Sensor Elements（传感器元件数量） — 定义滑条内的元件数量。一个良好

的 API 分辨率与传感器元件的比例是 20:1。过多增大该比例会造成计算分辨率时噪声增

加。取值范围为[2…32]。默认值为 5 个元件。 

 API Resolution（API 分辨率） — 定义滑条的分辨率。位置值将在该范围以内变化。取值

范围为[1…255]。 

 Position Noise Filter（位置噪声滤波器） — 选择噪声滤波器的类型以进行位置计算。对

于一个选定的 Widget，仅可应用一个滤波器。有关滤波器类型的详情，请参见本数据手册

功能说明一节中的滤波器部分。 

□ None（无） 

□ Median（中值滤波）  

□ Averaging（均值滤波）  

□ First Order IIR 1/2（一阶 IIR1/2 滤波）  

□ First Order IIR 1/4 (default)(一阶 IIR1/4 滤波，默认） 

□ Jitter（抖动滤波）  
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Tuning（调试）： 

 Finger Threshold（手指阈值） — 定义增加或减少触摸灵敏度的传感器活动阈值。当传感

器扫描值大于该阈值时，该按键被报告为“有触摸”状态。默认值为 100。  

 Noise Threshold（噪声阈值） — 定义滑条元素的传感器噪声阈值。如果计数值高于该阈

值，则不更新基准线。如果噪声阈值过低，传感器和热偏移可能被忽略不计。这样会导致

触摸错误或触摸遗漏。如果噪声阈值过高，手指触摸可能会被解释为噪声，且认为增加基

准线，导致中心位置计算错误。中心计算中不包括低于该阈值的计数值。默认值为 20。8

位分辨率 widget 的有效值范围是 [1…255]，16 位分辨率 widget 的有效值范围是

[1...65535]。 

 Scan Resolution（扫描分辨率）— 用于定义扫描分辨率。该参数对辐条滑块 widget 内所

有传感器的扫描时间会产生影响。N 位的扫描分瓣率的最大原始计数为 2N – 1。 提高分辨

率可提高触摸检测的灵敏度和信噪比，但会增延长描时间。默认值为 10 位。取值范围为

[6…16]。 

注意：这些参数不适用于 SmartSense 模式并由 SmartSense 算法自动设置。 

Matrix Buttons（矩阵按键） 

 

 

Tuning（调试）： 

 Column and Row Finger Threshold（列/行手指阈值） — 定义相关触摸灵敏度增大或减

小的 matrix button（矩阵按键）列和行的传感器活动阈值。当传感器扫描值大于该阈值

时，该按键被报告为“有触摸”状态。默认值为 100。8 位分辨率 widget 的有效值范围是
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[1…255]，16 位分辨率 widget 的有效值范围是[1..65535]。8 位分瓣率 widget 的 Finger 

Threshold + Hysteresis 的值不能大于 254，16 位分瓣率 widget 的值不能大于 65534。 

 Column and Row Noise Threshold（列/行噪声阈值） — 定义矩阵按键列和行的传感器

噪声阈值。如果计数值高于该阈值，则不更新基准线。如果噪声阈值过低，传感器和热偏

移可能被忽略不计。这样会导致触摸错误或触摸遗漏。如果噪声阈值过高，手指触摸可能

会被解释为噪声，且认为增加基准线。这样会导致触摸遗漏。默认值为 20。8 位分辨率

widget 的有效值范围是[1…255]，16 位分辨率 widget 的有效值范围是[1...65535]。 

 Column and Row Hysteresis（列/行迟滞）— 添加矩阵按键列和行的传感器活动状态转

换的差分迟滞。如果传感器处于非活动状态，则差值计数必须大于手指阈值与迟滞的和才

被认为是有效的状态转换条件。如果传感器处于活动状态，则差值计数必须低于手指阈值

与迟滞的差才被认为是有效的状态转换条件。迟滞有助于确保低振幅传感器噪声以及手指

少量移动不会导致按键状态的循环。默认值为 10。8 位分瓣率 widget 的有效值范围是

[1…255]，16 位分瓣率 widget 的有效值范围是[1…65535]。8 位分瓣率 widget 的 Finger 

Threshold + Hysteresis 的值不能大于 254，16 位分瓣率 widget 的值不能大于 65534。 

 Column and Row Debounce（列/行去抖动） — 添加矩阵按键列/行的传感器活动状态切

换检测的去抖动计数器。为了让传感器能够从未激活状态切换为激活状态，在规定的样本

数量内，差异计数值必须大于手指阈值与迟滞之和。默认值为 5。Debounce（去抖动）确

保高频率高振幅的噪声不会导致对按键的误检。值的有效范围为[1…255]。 

 Column and Row Scan Resolution（列/行扫描分辨率）— 定义矩阵按键列和行的扫描分

辨率。该参数对矩阵按键 widget 列/行内所有传感器的扫描时间产生影响。N 位的扫描分瓣

率的最大原始计数为 2N – 1。提高分辨率可提高触摸检测的灵敏度和信噪比，但会增延长

描时间。列和行扫描分辨率应相同，以获得相同的灵敏度水平。默认值为 10 位。取值范围

为[6…16]。 

注意：这些参数不适用于 SmartSense 模式并由 SmartSense 算法自动设置。 

 

General（通用）： 

 Number of Sensor Columns and Rows（列/行传感器数量） — 定义形成矩阵的列和行

的数量。取值范围为[2…32]。列和行的元件数量默认值为 5。 
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Touchpads（触控板） 

 

 

Tuning（调试）： 

 Column and Row Finger Threshold（列/行手指阈值） — 定义导致触摸灵敏度增大或减

小的触摸板列和行的传感器活动阈值。当传感器扫描值大于该阈值时，触摸板将报告触摸

位置。默认值 100。8 位分瓣率 widget 的有效值范围是[1…255]，16 位分辨率 widget 的有

效值范围是[1...65535]。  

 Column and Row Noise Threshold （列/行噪声阈值）— 定义触摸板列和行的传感器噪

声阈值。如果计数值高于该阈值，则不更新基准线。中心位置计算不包括低于该阈值的计

数值。如果噪声阈值过低，传感器和热偏移可能被忽略不计。这样会导致触摸错误或触摸

遗漏。如果噪声阈值过高，手指触摸可能会被解释为噪声，且认为增加基准线。这样可造

成中心计算错误。默认值为 20。8 位分瓣率 widget 的有效值范围是[1…255]，16 位分辨率

widget 的有效值范围是[1...65535]。 

 Column and Row Scan Resolution（列/行扫描分辨率）— 定义触摸板列和行的扫描分辨

率。该参数对触摸板 widget 列/行内所有传感器的扫描时间产生影响。N 位的扫描分瓣率的

最大原始计数为 2N – 1。 提高分辨率可提高触摸检测的灵敏度和信噪比，但会增延长描时

间。列和行扫描分辨率应相等，以获得相同的灵敏度水平。默认值为 10 位。取值范围为

[6…16]。 

注意：这些参数不适用于 SmartSense 模式并由 SmartSense 算法自动设置。 
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General（通用）： 

 Numbers of Sensors Column and Row(列/行传感器数量）— 定义组成触摸板的列和行

的数量。取值范围为[2…32]。列和行的元件数量默认值均为 5。 

 API Resolution Column and Row（列/行 API 分辨率） — 定义触摸板列和行的分辨率。

在该范围内将报告手指的位置值。取值范围为[1…255]。 

 Position Noise Filter（位置噪声滤波器） — 将噪声滤波器添加到位置计算中。对于一个

选定的 Widget，仅可应用一个滤波器。有关滤波器类型的详情，请参见本数据手册中功能

说明一节的滤波器部分。 

□ None（无） 

□ Median（中值滤波）  

□ Averaging（均值滤波）  

□ First Order IIR 1/2（一阶 IIR1/2 滤波） 

□ First Order IIR 1/4 (default)(一阶 IIR1/4 滤波，默认） 

□ Jitter（抖动滤波）  

Proximity Sensors（接近传感器） 

 

注意：除了接近 Widget 外，所有 Widget 默认情况下为启用状态。由于接近 Widget 的扫描时间较

长，不符合其它 Widget 类所需的快速响应，因此必须在 API 中手动使能接近 Widget。使用

CapSense_EnableWidget()函数启用接近 widget。 
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General（通用）： 

 Number of Dedicated Sensor Elements — 选择专用接近传感器的数量。这些传感器单

元不包括用于其它 Widget 类型的传感器。任何 Widget 传感器均可单独使用，或并行连接

来实现接近传感器。 

□ 0 — 接近传感器仅扫描一个或多个现有传感器来确定接近情况。没有任何新传感器

被分配给该 Widget。 

□ 1（默认） — 系统中专用接近传感器的数量。  

Tuning（调试）： 

 Finger Threshold（手指阀值） — 定义导致触摸接近灵敏度增大或减小的传感器的活动阈

值。当传感器扫描值大于此阈值时，该接近传感器报告为有触摸。默认值为 100。8 位分瓣

率 widget 的有效值范围是[1…255]，16 位分辨率 widget 的有效值范围是[1..65535]。8 位

分瓣率 widget 的 Finger Threshold + Hysteresis 的值不能大于 254，16 位分瓣率 widget

的值不能大于 65534。 

 Noise Threshold（噪声阈值） — 定义传感器噪声阈值。如果计数值高于该阈值，则不更

新基准线。如果噪声阈值过低，传感器和热偏移可能被忽略不计。这样会导致触摸错误或

触摸遗漏。如果噪声阈值过高，手指触摸可能会被解释为噪声，且认为增加基准线。这样

会导致触摸遗漏。8 位分辨率 widget 的有效值范围是[1…255]，16 位分辨率 widget 的有效

值范围是[1..65535]。 

 Hysteresis（迟滞） — 添加传感器活动状态转换的差分迟滞。如果传感器处于非活动状

态，则差值计数必须大于手指阈值与迟滞的和才被认为是有效的状态转换条件。如果传感

器处于活动状态，则差值计数必须低于手指阈值与迟滞的差才被认为是有效的状态转换条

件。迟滞有助于确保低振幅传感器噪声以及手指和身体的小幅移动不会导致接近传感器状

态的循环。8 位分辨率 widget 的有效值范围是[1…255]，16 位分辨率 widget 的有效值范围

是[1...65535]。 

 Debounce（去抖动） — 添加一个去抖动计数器来检测传感器活动状态转换。为了让传感

器能够从未激活状态切换为激活状态，在规定的样本数量内，差异计数值必须大于手指阈

值与迟滞之和。去抖动确保高频率高振幅的噪声不会导致对接近事件的误检。取值范围为

[1…255]。 

 Scan Resolution（扫描分辨率） — 定义扫描分辨率。该参数对接近 Widget 的扫描时间

产生影响。N 位的扫描分瓣率的最大原始计数为 

2N – 1。提高分辨率可提高触摸检测的灵敏度和信噪比，但会增加扫描时间。我们建议接近

检测使用的分辨率应比典型按键所使用的分辨率更高，以增大检测范围。默认值为 10 位。

取值范围为[6…16]。 

注意：这些参数不适用于 SmartSense 模式并由 SmartSense 算法自动设置。 
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Generics（通用） 

 

 

Tuning（调试）： 

 Scan Resolution（扫描分辨率）— 用于定义扫描分辨率。该参数会影响通用 Widget 的扫

描时间。N 位的扫描分辨率最大原始计数为 2N – 1。提高分辨率可提高触摸检测的灵敏度和

SNR（信噪比），但会增加扫描时间。默认值为 10 位。 

为每个通用 Widget 仅提供一个调试选项，因为所有高级处理均留给客户，以支持不适于任何预定

义 Widget 的 CapSense 传感器及算法。 
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Scan Order（扫描顺序）选项卡 

 

注意：扫描顺序对性能不产生任何影响；默认扫描顺序符合大多数应用。 

工具栏 

工具栏包含以下指令： 

 Up/Down（上/下）（热键 — 加/减） — 使选定的 Widget 在数据网格中上下移动。如果选

中了 Widget 的一个或多个元件，则将选定整个 Widget。 

注意：如果扫描顺序变化，则应重新分配引脚。 

注意：默认情况下接近传感器不参与扫描过程。其扫描必须在运行时手动启动，因为它通常与其

它传感器不同时扫描。 

其它热键： 

 Ctrl + A — 选择所有传感器。 

 Delete — 从复合传感器中删除所有传感器（仅适用于通用和接近 widget）。 
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感应时钟分频列 

指定感应时钟分频值，并确定扫描槽的预充电开关输出频率。PSoC 4100/PSoC 4200 器件的取值

范围为[2…255]，PSoC 4000 器件的取值范围为[1…255]。默认值为 2。 

如果（在“Advanced”选项卡上的）Individual frequency setting（单一频率设置）被禁用，

则该列会隐藏。 

调制器时钟分频列 

指定调制器时钟分频值，并确定扫描槽的调制器输入频率。PSoC 4100/PSoC 4200 器件的取值范

围为[2…255]，PSoC 4000 器件的取值范围为[1…255]。默认值为 2。 

如果（在“Advanced”选项卡上的）Individual frequency setting（单一频率设置）被禁用，

则该列会隐藏。 

调制 IDAC 值 

指定调制 IDAC 值。4x 范围的有效范围介于 0 至 255（对于 PSoC 4100/ PSoC 4200 器件为 0 至

250）之间，8x 范围的有效范围为 0 至 125。默认值为 200。有关 IDAC 配置的详情，请参见本数

据手册中功能说明一节的 CapSense 模拟系统部分。 

补偿 IDAC 值 

指定补偿 IDAC 值。有效范围为 0 至 127。默认值为 80。 

注意：感应时钟分频、调制器时钟分频、补偿 IDAC 和调制 IDAC 参数均不适用于 SmartSense 模

式。有关 SmartSense 和手动模式中的其它调试信息，请参见 CapSense 调试过程一节。 

SmartSense 模式中的灵敏度参数表示激活传感器时所需的 Cs（传感器电容）的额定变化。取值

范围为[1…10]，对应的灵敏度级别为：0.1、0.2、0.3 以及 1 pF。默认值为 2。推荐的范围为 0.1-

0.4 pF。针对覆盖层材料的不同厚度，通过灵敏度参数设置传感器的整体灵敏度。材料越厚，灵敏

度值越低。 

Widget 列表 

Widget 以灰色和橙色交替行的形式在表中列出。与 Widget 相关的所有传感器使用相同的颜色，

以高亮显示不同的 Widget 元件。 

接近扫描传感器可使用专用接近传感器，或它们可以从专用传感器和/或其他传感器的组合中检测

接近性。例如，电路板可能有一根围绕着按键阵列的线路，且接近传感器可能由该线路和阵列中

的所有按键组成。所有这些传感器均同时扫描，以检测接近。在接近扫描传感器上提供了下拉菜

单，可选择进行扫描的一个或多个传感器，以检测接近。  

与接近传感器一样，通用传感器也可由多个传感器组成。通用传感器可从专用传感器、任何其它

现有传感器或多个传感器中获取数据。从提供的下拉菜单中选择传感器。 
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Advanced（高级）选项卡 

 

Current Source（电流源） 

CapSense CSD 要求高精度的电流源，以检测在传感器上的触摸。IDAC Sinking 和 IDAC 

Sourcing 需要使用 PSoC 器件上的 IDAC。  

 IDAC Sourcing（默认）— IDAC 将电流提供到调制电容 CMOD。模拟开关经配置在调制电

容 CMOD和 GND 之间交替，提供电流放电通路。建议在大多数设计中使用 IDAC 

Sourcing，因为与其它两种方法相比，它提供的信噪比最高，但可能要求额外的 VDAC 资

源来设置其它模式并不要求的 Vref 电平。 

 IDAC Sinking — IDAC 从调制电容 CMOD吸收电流。模拟开关经配置在 VDD 和调制电容

CMOD之间交替，提供电流源。尽管信噪比通常没有 IDAC Sourcing 模式高，但该模式适

用于大多数设计。  
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IDAC range（IDAC 范围） 

此参数指定 Current Source（电流源）的 IDAC 范围。如果将 Current Source 项设置为

External Resistor（外部电阻），则禁用该参数。默认值是几乎所有 CapSense 设计的最佳选

择。较低和较高的电流范围通常仅用于非触控电容式传感器。 

 4x（默认值） 

 8x 

Analog Switch Drive Source（模拟开关驱动源） 

该参数指定感应时钟分频的来源，以确定传感器切换到/出调制电容 CMOD的速率。 

 Direct (default) （直接 — 默认值） 

 PRS-8b  

 PRS-12b 

 PRS-Auto 

Individual Frequency Settings （单独频率设置） 

该参数定义了感应时钟分频的使用。如果使能该参数，每个扫描槽将使用特定的感应时钟分频值

（在 Scan Order 选项卡下设置）。否则，传感器只使用该参数下面设置的感应时钟分频值和调

制器时钟分频值。如果各个传感器的寄生电容不同，推荐使用单独频率设置。 

Sense Clock Divider（感应时钟分频） 

该参数指定感应时钟分频值，并确定预充电开关输出频率。PSoC 4100/PSoC 4200 器件的取值范

围为[2…255]，PSoC 4000 器件的取值范围为[1…255]。默认值为 12。 

如果使能 Individual Frequency Settings 项，该性不可用。 

传感器以预充电时钟的速度不断切换至或从调制电容 CMOD 切换。感应时钟分频对 CapSense 

CSD 时钟进行分频，产生预充电时钟。当分频器值减少时，传感器以更快的速度切换，原始计数

增加，并反之亦然。  

有关 IDAC 配置的详情，请参见本数据手册中功能说明一节的 CapSense 时钟部分。 
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Modulator Clock Divider（调制器时钟分频） 

该参数用于指定调制器时钟分频值，并确定调制器输入频率。PSoC 4100/PSoC 4200 器件的取值

范围为[2…255]，PSoC 4000 器件的取值范围为[1…255]。默认值为 12。 

分频值越低，扫描时间越短，并反之亦然。 

如果使能 Individual Frequency Settings 项，该性不可用。 

注意：在 PSoC 4100/PSoC 4200 器件中，调制器时钟分频值要为感应时钟分频值的倍数，因为

这些分频值是相关联的。更多有关信息，请参考 CapSense 时钟一节。 

感应时钟分频和调制器时钟分频在 SmartSense 模式中不可用。有关 SmartSense 和手动模式中

的其它调试信息，请参见 CapSense 调试过程一节。 

Sensor Auto Reset（传感器自动复位） 

该参数启用自动复位，从而使基准线随时更新，无论差值计数高于或低于噪声阈值。如果禁用自

动复位，则只有差值计数在正/负噪声阈值（噪声阈值为镜面值）以内时，基准线才会更新。如果

在无传感器触摸而原始信号突然上升时，传感器始终打开，要使能该参数，否则应将其保留为

Disabled（禁用）。 

 Enabled（启用） — 自动复位确保基准线随时更新，从而避免按键按压遗漏和按键卡住，

但限制了报告按键被按压的最大持续时间。此设置限制传感器的最大持续时间（典型值为 5

到 10 秒），但是当无任何传感器触摸而原始信号（raw count）突然上升时，可以阻止传

感器始终打开。原始信号突然上升可能是由电源电压剧烈波动、高能射频噪声源或温度快

速变化所导致。  

 Disabled（禁用）（默认）— 系统的异常会通过持续超出噪声阈值的方式使基准线停止更

新。从而造成按键按压遗漏或按键卡住。其优势是，按键可以持续报告其被按压状态。设

计人员可能需要提供一种确定按键是否卡住或无反应的应用方法。 
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Widget Resolution（Widget 分辨率） 

该参数定义了 widget 所报告的信号分辨率。8 位（1 字节）是默认选项，适用于绝大多数应用场

合。如果 Widget 值超出 8 位范围，则系统过于敏感，应进行调试，将额定值移到近似中间范围

（~128）。要求高精度的滑条和触控板 Widget 可受益于 16 位分辨率。通过避免 8 位分辨率可能

出现的舍入误差，16 位分辨率可增加线性度，但条件是每个传感器会多使用两个字节的 SRAM。 

 8 位（1 字节） — 默认  

 16 位（2 字节） 

Negative Noise Threshold（负噪声阈值） 

该参数指定原始计数和基准线级别之间的负差值，用于将基线复位到原始计数级别。如果原始计

数低于该级别，基准线将不复位，除非达到 Low Baseline Reset（低基准线复位）参数的限制。

在这种情况下，将复位基准线。下图显示的是噪声阈值和基准线复位之间的关系。负噪声阈值的

良好起点是使用噪声阈值的起点。 

取值范围为[5…255]。默认值为 20。 
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Baseline does not update

Positive Noise Threshold

Baseline will update

Baseline

Baseline will update

Negative Noise Threshold
Baseline does not update

unless samples > Low Baseline Reset  

 

Low Baseline Reset（低基准线复位） 

该参数定义了复位基准线到原始计数（raw count）必须经过的采样次数，这种采样中原始计数

（raw count）必须小于基准线值。取值范围为[1…255]。默认值为 5。 

Inactive Sensor Connection（非活动状态传感器连接） 

该参数定义了没有经过主动扫描的所有传感器的默认传感器连接。 

 Ground（默认）— 应当用于绝大多数应用场合，因为这样可以减少主动扫描的传感器噪

声。 

 Hi-Z Analog — 使非活动状态传感器处于高阻抗模式。 

 Shield — 给所有未扫描传感器提供屏蔽波形。屏蔽信号的振幅等于扫描传感器上的信号振

幅。当与屏蔽电极一起使用时，可增强防水能力并降低噪声。如果屏蔽被禁用，该功能不

可用。 

Shield（屏蔽电极） 

该参数指定启用或禁用屏蔽电极输出，屏蔽电极输出用于消除水滴或水膜的影响。有关屏蔽电极

使用的更多信息，请参考屏蔽电极一节。 

 Disabled（default）（禁用 — 默认选择） 

 Enabled（使能）  

Shield signal delay（屏蔽信号延迟） 

该参数用于指定 CSD Shield 相对于 csd_sense 的延迟 HFCLK 周期数。  

 None (default)（无 — 默认） 

 1 cycle（1 个周期） 
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 2 cycle（2 个周期） 

Shield tank capacitor enable（屏蔽槽电容启用） 

该参数用来指定是否启用将片外 Ctank 电容与屏蔽电容并联的引脚。该电容用于增加屏蔽电容。

同样，将 Cmod 预充电或 Csh_tank 预充电设置为“Precharge by IO buffer”（通过 IO 缓冲进行

预充电）时，也要启用 Ctank 电容。 

 Disabled (default)（禁用 — 默认选择） 

 Enabled（使能）  

Guard Sensor（保护传感器） 

该参数可启用保护传感器，有助于检测需要防水的应用中的水滴。如果选中（在 General 选项卡

下的）Water Proofing and detection（防水并检测），则启用该功能。有关保护传感器的更多

信息，请参见本数据手册的功能说明一节。 

 Disabled (default)（禁用 — 默认选择） 

 Enabled（使能） 

Cmod precharge（Cmod 预充电） 

该参数指定用于 Cmod 电容的预充电源。 

 通过 Vref 缓冲进行预充电（默认） 

 通过 IO 缓冲进行预充电 

Csh_tank precharge（Csh_tank 预充电） 

该参数指定用于驱动屏蔽电极的 Vref 源。 

 通过 Vref 缓冲进行预充电（默认） 

 通过 IO 缓冲进行预充电 
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Tune Helper（调谐助手）选项卡 

 

Enable Tune Helper（启用调谐助手） 

该参数添加了多种功能，使用户可轻松与调谐器 GUI 进行通信。如果要使用 Tuner GUI，请勾选

此特性。如果未选中此选项，仍然提供通信功能，但不执行任何操作。因此，当调试完成或调试

方法改变时，无需删除这些功能。默认禁用此选项。 

EzI2C component instance name（EZI2C 组件的实例名称） 

该参数定义了您的设计中将用于与调谐器 GUI 进行通信的 EZI2C 组件的实例名称。 

有关如何使用调谐器 GUI 的更多信息，请参考本数据手册中的调谐器 GUI 用户指南一节。 
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调谐器 GUI 用户指南 

本节提供了相关指令和信息，能帮助用户使用 CapSense 调谐器。 

CapSense 调谐器在手动调试模式下，根据特定的系统环境帮助调试 CapSense 组件。它还能够

在组件处于 SmartSense 模式下显示调试值（只读）和性能。当组件处于非调试模式时不支持调

试，因为所有参数均存储在闪存中，并且为实现最低 SRAM 使用率，这些参数处于只读状态。  

CapSense 调试过程 

使用和调试 CapSense 组件的典型过程如下： 

在 PSoC Creator 中创建设计 

若有需要，可以参考 PSoC Creator 帮助。 

放置并配置 EZI2C 组件 

1. 将 SCB 组件从组件目录拖入您的设计中。 

2. 双击它以打开 Configure 对话框。 
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3. 选中 EZI2C 选项，然后点击 EZI2C 选项卡。 

 

 

4. 按照下面内容更改参数： 

□ 将 Sub-address size (bits)（辅助地址大小（位））设置为 16。 

□ 实例名称必须匹配于 CapSense CSD 配置对话框中 Tuner Helper 选项卡下的名

称，这样生成的 API 才能工作。请参见配置调谐器助手。 

放置并配置 CapSense 组件 

1. 将 CapSense_CSD 组件从组件目录拖入您的设计中。 
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2. 双击它以打开 Configure 对话框。 

 

 

3. 根据您应用的需要更改参数。将 Tuning method（调试方法）选择为 Manual 或 Auto 

（SmartSense）。 

 

选中 Auto（SmartSense） 

自动（SmartSense）允许用户根据特定系统的具体情况自动调试 CapSense CSD 组件。

在运行时，通过固件计算 CapSense CSD 参数。该模式中使用了额外的 RAM 和 CPU 时

间。自动（SmartSense）消除了手动调试 CapSense CSD 组件参数容易产生错误和重复

过程的问题，确保系统正确工作。选择自动（SmartSense）将调试以下 CSD 参数： 

参数 计算 

手指阈值 在传感器扫描期间连续计算。 

噪声阈值 在传感器扫描期间连续计算。 

补偿IDAC 启动CapSense CSD后立即计算该参数。 

调制IDAC 启动CapSense CSD后立即计算该参数。 

感应时钟分频 启动CapSense CSD后立即计算该参数。 

调制器时钟分频 启动CapSense CSD后立即计算该参数。 

负噪声阈值 启动CapSense CSD后立即计算该参数。 

低基准线复位 启动CapSense CSD后立即计算该参数。 

 



PSoC
®
 Creator™ Component Datasheet PSoC 4 Capacitive Sensing (CapSense® CSD) 

Document Number: 001-92183 Rev. ** 页 29/95 

配置 Widget 

在 Widgets Config 选项卡上添加并配置“widgets”。 

 

 

配置调谐器助手 

在 Tune Helper 选项卡上：必须选中 Enable Tune Helper 选框。 
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添加代码 

将调谐器初始化和通信代码添加到项目 main.c 文件中。main.c 文件示例： 

void  main() 

{  

    CyGlobalIntEnable;  

    CapSense_1_TunerStart(); 

 

    /*All widgets are enabled by default except proximity widgets. Proximity 

    widgets must be manually enabled as their long scan time is incompatible 

    with the fast response required of other widget types. 

    */ 

 

    while(1) 

    { 

        CapSense_1_TunerComm(); 

    } 

} 

 

构建设计并编程 PSoC 器件 

若需要，可以参考 PSoC Creator 帮助。 
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启动调谐器应用 

右击 CapSense CSD 组件图标，然后从上下文菜单中选择 Launch Tuner 项。调谐器应用将打

开。 

 

配置通信参数 

1. 点击 Configuration 项，打开 Tuner Communication 对话框。 
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2. 设置通信参数，然后点击 OK。 

注意：I2C 地址、辅助地址和 I2C 速度字段与 SCB 组件中分别相应的主从设备地址、辅助地址大

小和数据速率必须相同。必须将辅助地址设置为两字节。 

开始调试 

点击调试 GUI 上的 Start 。所有 CapSense 元件开始显示它们的值。 

编辑 CapSense 参数值 

编辑其中一个元件的参数值，按[Enter]键或转入另一个选项后，参数值会自动应用。GUI 继续显

示扫描数据，但现在根据更新参数的应用发生了改变。请参考本数据手册后面的调谐器 GUI 界面

一节。 

 

根据需要重复各步骤 

根据需要重复上述各步骤，直到调试完成并 CapSense 组件提供可靠的触控传感器结果为止。 

关闭调谐器应用 

依次选择 File -> Apply Changes and Close，参数回写到 CapSense_CSD 实例。调谐器应用对

话关闭。 
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CapSense 验证过程 

验证机制确定电路板是否已经过充分调试。下面介绍的是使用调谐器验证特性来验证 CapSense

设计的典型过程。 

开始验证 

开始扫描前，必须准备好调谐器和硬件。请参见前面章节，CapSense 调试过程，准备系统进行扫

描的有关内容。 

在 Validation（验证）选项卡下，点击“Acquire Validation Data”（获取验证数据）。开始出现

所有 CapSense 元件对应的值。 
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激励传感器 

会有信息提示您在各传感器上用手指触摸。 

 

每次提示您按压 CapSense 元件时，布局图上会有闪烁的红色箭头指向目标，并有文字提

示 PRESS HERE（按此处）。Tuner 下方出现的文字将指导用户完成验证过程。 

要开始当前传感器的扫描，可按键盘上任意键。 

建议使用经过校准的仿真手指，而不是通过手指按压来激励传感器。 
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验证显示 

  

 

信噪比警告出现如下： 

□ 闪烁红色高亮区围绕所有信噪比小于 Sufficient Value（足够值）的 CapSense 传

感器。 

□ 闪烁黄色高亮区围绕信噪比介于 Sufficient（足够值）和 Optimal Values（最优

值）之间的任何 CapSense 传感器。 

□ 闪炼绿色高亮区围绕的 CapSense Sensor 信噪比高于 Optimal Values（最优

值）。 

串扰效应警告出现如下： 

□ Individual Crosstalk Check（单个串扰检查）。在验证过程中，软件监视除用户被

告知需激励的元件以外的所有元件。如果某一元件显示不同的计数，且超出

Crosstalk Threshold Percentage（串扰阈值百分比）（未直接激励时），则将产

生串扰警告。这通过一条闪烁的线来显示，这条线介于显示出非预期计数的元件和

受到激励的元件之间。 

□ Worst Case Crosstalk Check（最差情形串扰检查）进行每个单独串扰检查时，软

件将记录着各不同计数测量值。当这个过程完成时，最差情形串扰的估算完成。 
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针对各个传感器出现一个合计的数值，该数值等于 Worst Case Crosstalk Sensor Count

（最差情形串扰传感器计数）的串扰效应的数量。最大的串扰值是合计中第一个元件，第

二大是第二个，以此类推。例如，如果得到以下串扰计数（1、5、3、2、4、1、1、0），

而 Worst Case Crosstalk Sensor Count（最差情形串扰传感器计数）是 2，则 Worst 

Case Crosstalk（最差情形串扰）计算结果将为（5 + 4 = 9）。 

如果该值超过 Worst Case Crosstalk Threshold（最差情形串扰阈值），则会在所显示传

感器中间用闪烁的字符 “C”对其进行标记。 

验证结果 

如果验证过程发现了故障，则将显示 Validation Report（验证报告）。该报告包括以下信息： 

 低于 Optimal Value（最优值）的任何信噪比值。 

 低于 Sufficient Value（足够值）的任何信噪比值。 

 出现最差情形串扰故障的任何信号，以及出现该种故障的串扰个数 

可以通过点击 Validation （验证）选项卡上的 How do I fix this 按键，打开 Validation Report（

验证报告）。 
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手动调试过程 

9

10

Start

Set the switching frequency 

(Modulator Clock and Analog 

Switch Divider)

Set the IDAC to make the raw 

counts to 80% of the full scale 

(Is SNR > 5) 

Set Finger Threshold to 75% of 

peak finger response. 

Set the hysteresis to 15% of 

peak finger response

Set the noise threshold to 40% 

of the peak finger response

Set the Debounce as per 

design requirement

End

Monitor the raw counts in the 

Tuner with and without finger touch

Open the Tuner GUI to tune the 

CapSense CSD

Set the resolution to 10 bits as the 

initial value 

Yes

No

1

2

3

4

17

18

19

20

Enable the Shield electrode if 

needed in the design

Check the layout for improvement 

(refer to Getting Started with 

CapSense and if possible reduce the 

overlay thickness or increase the 

button size

Add firmware filters. Choose the 

type of filter based on the noise 

type present in the system

(Is SNR > 5) & (Does Scan 

Time meets design 

requirement)

Adjust the resolution and scan time 

such that the SNR is above 5:1 

and scan time within the spec

(Is SNR > 5) & (Does Scan 

Time meets design 

requirement)

No

No

Yes

Yes

Enable the PRS according to 

design requirement and set the 

PRS resolution (8 or 12 bits)

11

12

13

14

15

16

Compensation IDAC 

Enabled

Set the Modulation IDAC to the full 

scale

80% of full scale of raw 

counts is achieved

Decrease the Modulation IDAC

Yes

No

Yes

No

5

6

7

8
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1. 屏蔽的使能或禁用依设计要求而定。在传感器覆盖层可能变湿（请参见 AN2398）的应用

中，屏蔽电极可用于屏蔽 EMI，或降低过高的 Cp。更多信息，请参见本文档后面的屏蔽电

极一节。  

2. 各个电容式传感器的开关频率设置应能使传感器满充满放。Modulator Clock Divider（调

制器时钟分频）和 Sense Clock Divider（感应时钟分频）确定传感器电容的切换频率。

Modulator Clock （调制器时钟）（扫描时钟）是 CapSense 组件的首要时钟源。在

PSoC 4100/PSoC 4200 器件中，Sense Clock Divider（预分频）通过对调制器时钟进行

分频产生开关时钟，用来对各传感器进行充电和放电。如果传感器不完全充电或放电，可

通过增加 Sense Clock Divider 降低开关频率。 

如果已知传感器的寄生电容，可以计算 Sense Clock Divider，使模拟开关时钟的周期大于

10RCp 或模拟开关频率 < 1/(RCp)；其中，R 为电阻器的总电阻，并且模拟复用器总线和

开关（请参考 CapSense 模拟系统一节中的 SW3 内容）被连接到串联传感器寄生电容

Cp。 

要测试传感器是否满充满放，可通过探头探查各个传感器引脚。注意：通过示波器探头观

察传感器电容的电压时，应在传感器寄生电容中增加探头电容。在 10x 模式下使用探头可

减小探头电容。如果可能，可使用 FET 输入探头。确保电容器完全充放电；如果不能，可

在组件配置中增大 Sense Clock Divider 的值。在调谐器 GUI 中不能更改该参数，必须在

组件配置中进行设置。因此，当该值在组件 Configure 对话框中改变时，需要重建项目，

并针对器件进行编程。 

3. 默认启用 PRS，以减少外部 EMI 对 CapSense 的影响，并减少传感器扫描辐射。在易受

EMI 作用影响的设计中启动 PRS。PRS 的分辨率可设为 8 或 12 位，具体依扫描时间而

定。如果扫描时间较长，使用 PRS12；如果扫描时间较短，则使用 PRS 8。 

4. 打开 CapSense 调谐器 GUI，并将分辨率设置为 10。  

增加分辨率和模拟开关频率可以提高灵敏度，但会延长扫描时间。因此，需要在扫描时间

和灵敏度之间进行权衡。 

在调试过程中，如果设计中的外覆层厚度小于 1 毫米，8 和 9 也可用作初始值，但是分辨率

的最佳初始值应为 10。 

5. 若需要，使能补偿 IDAC。 

6. 如果使能了补偿 IDAC，将调制 IDAC 设置为满标度。 

7. 在 GUI 中更改补偿 IDAC 值，直到原始计数达到满标度值的 85%。分辨率全标度的值为 2

的分辨率次方。请注意，降低 IDAC 值可增加原始计数（raw count），反之亦然。如果任

何 IDAC 值都不能达到满标度值的 85%，则应在组件配置中更改 IDAC 的范围。IDAC 范围

不能在“Tuner GUI”中进行更改；而应在组件 Configure（配置）对话框中更改。当

Configure 对话框中的值变化以后，应再次构建项目，并针对器件编程它。  

8. 如果任何补偿 IDAC 值都不能达到满标度值的 80%，则应降低调制 IDAC 值并重复第 8 步

骤。 

http://www.cypress.com/?rID=2740
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9. 监测手指触摸和无手指触摸两种情况下的原始计数。请注意峰-峰噪声和峰值手指触摸响

应。按下面公式计算信噪比： 

SNR =
Peak Finger Response

Peak to Peak Noise when 

finger is not present
 

10.  同时，检查是否满足了设计的扫描时间要求。点击 GUI 上的 OK 按键，将 GUI 中经过调试

的值更新到组件中。组件根据参数设置计算出了扫描时间的近似值。扫描时间将显示在

“scan order”（扫描顺序）选项卡中。如果设计中分辨率高且扫描速度低的传感器数量

多，则所有传感器的总扫描时间会使传感器扫描间隔变得很长。  

11.  为获得良好的 CapSense 设计，信噪比应大于 5。检查总扫描时间是否符合设计要求。如

果未达到信噪比要求，请增加固件滤波器。请参考滤波器一节，然后选择与系统噪声相适

应的滤波器类型。对于大部分设计，从一阶 IIR 1/4 滤波器开始，因为它要求的 SRAM 最

小，并能提供快速响应。 

如果信噪比低于 5，会增加分辨率、扫描速度，或两者。这样，扫描时间将相应延长。因

此，分辨率和扫描时间两者均应进行调试，以便达到高于 5 的信噪比，并使扫描时间低于

设计规定。再次检查信噪比和扫描。如果不能达到 5:1 的信噪比并将扫描时间限制在设计规

定范围内，请从 PCB 布局或覆盖层设计中寻找可改进之处。请参考 CapSense 入门，了解

PCB 设计指导。您也可以减小覆盖层的厚度、或增加按键直径，都可以增加灵敏度。 

12. 达到 5:1 的信噪比后，需要设置以下固件参数。  

□ Finger Threshold（手指阈值）是用于确定传感器是否处于活动状态的阈值参数。将

该值设为手指峰值响应的 75%。  

□ 将迟滞设为手指峰值响应的 15%。 

□ 将噪声阈值设为手指响应的 40%。 

□ 平稳性确保像静电放电事件这样的高频、高振幅噪声不至于引起按键激活。去抖值

应是很小的数，比如 1 或 2，因为能够触发假按键触发的尖峰信号或高频噪声不会有

两个扫描长度那么宽。在快速扫描设计中，去抖值应设置为更高的值，比如 5。 

http://www.cypress.com/?rID=48787


PSoC 4 Capacitive Sensing (CapSense® CSD) PSoC
®
 Creator™ Component Datasheet 

页 40/95 Document Number: 001-92183 Rev. **  

调谐器 GUI 界面 

通用界面 

 

工作区 

工作区包括下面选项卡： 

 Tuning — 显示在工作区配置的所有组件 Widget。这样，您就可以按照 Widget 出现在物理

PCB 或外壳的类似方式对 Widget 进行排列。该选项卡用来调试 Widget 参数以及可视化

Widget 数据和状态。 

 Graphing — 在图表上详细显示单个 Widget 数据。 

 Validation — 提供验证功能。 

 Debugging — 提供调试功能。 
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菜单 

主菜单提供了用于控制和转到调谐器的以下指令： 

 File > Settings > Load Settings from File (Ctrl + O) — 从 XML 调试文件导入设置并将所

有数据加载到调谐器。 

 File > Apply Changes and Close (Ctrl + F4)— 将参数的当前值应用到 CapSense 组件实

例，并退出 GUI。 

 File > Exit (Alt + F4) — 要求保存任何若有的修改，并关闭调谐器。 

 View > Sensor Properties (Alt + 1) — 显示了 Sensor Properties（传感器属性）工具窗

口。 

 View > Graphing Properties (Alt + 2) — 显示了 Graphing Properties（图解属性）工具

窗口。 

 View > Logging Properties (Alt + 3) — 显示了 Logging Properties（日志属性）工具窗

口。 

 View > Reset Widgets Layout (Alt + R) — 重复 Tuning 选项卡中的 Reset Widgets 

Layout 按键。 

 Debug > Start (F5) — 开始读取和显示芯片的数据。如果配置，还启动图解和日志。 

 Debug > Stop (F6) — 停止从芯片上读取和显示数据。 

 Debug > Configuration (F10) — 打开 Communication Configuration 对话框； 

 Validation > Acquire Validation Data (Alt + V) — 重复 Validation 选项卡中的 Acquire 

Validation Data 按键； 

 Validation > Validation Advanced Properties (Ctrl + Alt + V) — 重复 Validation 选项卡

中的 Advanced 按键； 

 Validation > How do I fix this (Ctrl + H) — 重复 Validation 选项卡中的 How do I fix this

按键； 

 Tools > Enable Logging — 使能将从器件收到的数据日志到日志文件中。 

工具栏 

包含在主菜单中重复的常用按键： 

 Start — 重复 Debug > Start 菜单条目； 
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 Stop — 重复 Debug > Stop 菜单条目； 

 Configuration — 重复 Debug > Configuration 菜单条目； 

 Revert Parameters（还原参数） — 将参数重置为其初始值，并将这些值发送到芯片。初

始值为启动 GUI 时所显示的值。 

工具窗口 

工具窗口是可以随时显示并独立于当前选中的选项卡的窗口。工具窗口可以放置在调谐器的右

方、左方、上端或下端。通过拖放窗口标题可以将所有窗口放在一起，或通过拖动工具窗口下方

的特定页面使各窗口分开。 

状态栏 

显示调谐器和器件之间的当前通信状态。 

 

调试选项卡 

 

 Widgets schematic（Widgets 原理图）— 包含所有配置的 Widget 的图形表示。如果

Widget 由多个传感器组成，可以选定单个传感器进行详细分析。每一 Widget 均可在原理

图内移动。 
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 Reset Widgets Layout（重置 Widget 布局）按键 — 将各 Widget 移动到原理图内的默认

位置。 

 Widget 控件上下文菜单（此功能仅适用于 GUI 内 Widget 控件的布局）： 

□ Send To Back（置于背面）— 将 Widget 控件置于视图背面。 

□ Bring To Front（置于正面）— 将 Widget 控件置于视图正面。 

□ Rotate Clockwise 90（顺时针旋转 90 度）— 将 Widget 控件顺时针旋转 90 度。

（仅适用于线性滑条）。 

□ Rotate Counter Clockwise 90（逆时针旋转 90 度）— 将 Widget 控件逆时针旋转

90 度。（仅适用于线性滑条）。 

□ Flip Sensors（翻转传感器）— 颠倒传感器的顺序。（仅适用于线性和辐射滑

条）。 

□ Flip Columns Sensors（翻转列中的传感器）— 颠倒列中传感器的顺序。（仅适用

于触控板和矩阵按键）。 

□ Flip Row Sensors（翻转行中的传感器）— 颠倒行中传感器的顺序。（仅适用于触

控板和矩阵按键）。 

□ Exchange Columns and Rows（交换行列）— 将列中的传感器置于行中，行中的

传感器置于列中。（仅适用于触控板和矩阵按键）。 

传感器属性工具窗口 

传感器属性工具窗口显示了在 Tuning 选项卡中选定的传感器的特性和它的信号值。 

 Active sensor（活动传感器） — 下拉列表位于工具窗口的上端，并显示了选定传感器的

名称。可以随时选择活动传感器，而不依赖于当前选中的选项卡。 

 Bar graph（条形图） — 显示选定传感器的信号值： 

□ 通过双击 Max Value（最大值）标签，可调整到详细视图条形图的最大比例。8 位

Widget 分辨率的有效范围介于 1 和 255 之间，默认值为 255。16 位 Widget 分辨率

的有效范围介于 1 和 32767 之间，默认值为 32767。 

□ 当前手指打开阈值显示为穿过条形图的一条绿线。 

□ 当前手指关闭阈值显示为穿过条形图的一条红线。 

□ 当前噪声阈值显示为穿过条形图的一条黄线。 

□ 通过鼠标向上或向下移动这些线，可以设置阈值和迟滞。 
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 SNR（信噪比） — 对选定传感器的信噪比进行实时计算。信噪比值低于 5 表示不佳，显示

为红色；5 至 10 表示临界，显示为黄色；大于 10 表示良好，显示为绿色。根据之前接收

到的数据计算信噪比。 

 Sensor properties（传感器属性）（属性网格位于条形图下方） — 根据 Widget 类型，显

示选定传感器的属性。其位于右侧面板上。 

 General CapSense properties（CapSense 的常规特性属性）（属性网格位于传感器特性

网格下面，并为只读的） — 显示 CapSense CSD 组件的全局属性，该属性不可在运行时

进行更改。下列内容仅供参考。其位于右侧面板底部。 

Graphing Tab（图解选项卡） 

 

图表区域 

显示从树视图中所选项目的图表。如果右键单击菜单项 Export to .jpg，则能生成图表区的屏幕截

图，保存为“.jpg”格式文件。 

图解属性工具窗口 

图解属性工具窗口允许选择在图表区域中显示的传感器和类型。 

 Tree view（树视图） — 提供显示在图表区域中的各种组合的 Widget 和传感器数据。  
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日志属性工具窗口 

日志属性工具窗口允许选择日志到文件中的传感器和传感器类型。 

 Tree view（树视图） — 提供各种组合的 Widget 和传感器数据，这些数据在日志功能启用

时可被日志到文件中。开/关状态数据的值只能得到记录，不能显示在图表中。  

 Append new data to existing file（将新数据附加到现有文件） — 选中该选项后，新数据

即会附加到现有文件中。如果未选中，旧文件将从文件中被擦除，代之以新数据。 

 Log duration（记录持续时间）— 定义记录持续时间，单位为分钟。默认值为 10； 

 Log file name — 定义日志文件的路径（文件扩展名为“.csv”）。 

Validation（验证）选项卡 

 

Validation选项卡仅用于诊断目的。该选项卡有Widget布局视图，但不能对布局进行编辑。这个布

局部分只能用于显示。 

 Widgets schematic（Widgets 原理图）— 包含所有配置的 Widget 的图形表示。  

顶部面板控件： 

 Validation Status 标签 — 显示验证状态。它有以下信息： 
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□ VALIDATION NOT STARTED — 自上次设计修改以来，未进行过验证过程。 

□ PASS — 完整验证过程已完成，且无故障。 

□ FAIL — 验证过程发现了故障；将显示验证报告。 

 Acquire Validation Data 按键（或主菜单项 Validation > Acquire Validation Data）— 

开始验证过程。该过程引导用户完成一系列操作，在其中会提示您按顺序按压各传感器。 

 How do I fix this 按键 — 打开一个报告，上面列出未通过验证传感器的建议修复方案。只

有先前完成了验证过程并发现了设计错误的情况下，该按键才可用。 

 Advanced 按键（或主菜单项 Validation > Validation Advanced properties）— 打开验

证属性的验证窗口（更多信息，请参考验证高级属性一节）。 

 SNRs（信噪比）按键 — 在 Widget 原理图上打开或关闭信噪比显示（更多信息，请参见验

证显示部分）。 

 Crosstalks（串扰）按键 — 在 Widget 原理图上打开或关闭串扰显示（更多信息，请参见

验证显示部分）。 

Debugging（调试）选项卡 

 

该功能的存在仅为调试目的。它能帮助用户研究调谐器通信错误。 
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 Debugging log window（调试日志窗口） — 显示调谐器执行的通信指令。所有通信日志

错误均被记录于此。如果成功启动了调谐器，则仅记录最开始的几条通信指令。 

 Connect（连接）— 连接到 PSoC 器件； 

 Disconnect（断开连接）— 断开与 PSoC 器件的连接； 

 Address （地址）— 指出 PSoC 器件的地址；  

 Read（读取）— 从 PSoC 器件读取数据。地址字段定义缓冲区中的地址。数据字段定义待

读取的字节数； 

 Write（写入）— 将数据写入 PSoC 器件内。地址字段定义缓冲区中的地址。数据字段定义

待写入的数据。 

验证高级属性 

 

 Optimal SNR Value（信噪比最佳值）— 定义最佳的信噪比值。有效范围介于 0 和 100 之

间，默认值为 7。 

 Sufficient SNR Value（信噪比充分值）— 定义充分的信噪比值。有效范围介于 0 和 100

之间，默认值为 5。 

 Crosstalk Threshold Percentage（%）（串扰阈值百分比）— 定义每一传感器串扰阈值

占手指阈值的百分比。有效范围介于 0 和 100 之间，默认值为 20。 

 Worst Case Crosstalk Threshold Percentage（%）（最差情形串扰阈值百分比）— 定

义最差情形串扰阈值占最差情形串扰的百分比。有效范围介于 0 和 100 之间，默认值为

30。 
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 Worst Case Crosstalk Sensor Count（最差情形串扰传感器计数）— 定义用于计算最差

情形串扰传感器的数量；有效范围从 0 到 100；默认值为 2。 

 Enable Validation Logging（启用验证日志）— 使能对验证数据的日志。 

 Path（路径）— 定义验证数据日志文件的路径（文件扩展名为“.csv”）。 

 Auto Append Measurement Number（自动附加测量编号）选框  — 如果勾选，在每次启

动验证过程后，日志文件名将会递增（如“validation001.csv”），数据将被保存在一个新

文件中。 

Save and Load Settings（保存/加载设置）功能 

调谐器 GUI 也可以作为独立应用程序打开。在这种情况下，用户必须使用 CapSense CSD 组件调

谐器 GUI 的“保存和加载设置”功能。  

1. 点击定制器中的 Save Settings 按键。 

 

2. 在 Save File 对话框中，指定文件的名称及其保存位置。 

3. 打开调谐器窗口，然后依次选择 File > Settings > Load Settings from File。 

 

4. 在 File Open 对话框中，通过组件设置指向之前保存的文件。设置会自动载入调谐器中。 
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应用编程接口 

通过应用编程接口（API），您可以使用软件对组件进行配置。下表对各个函数进行了概述。以下

各节将对每个函数加以说明。 

组件可用于支持以下编译器的集成开发环境（IDE）中： 

 Keil 8051 编译器 

 ARM GCC 编译器 

 ARM RealView 编译器 

 IAR C/C++编译器 

注意：使用 IAR 嵌入式工作台时，需要创建到静态库的路径。该库位于以下 PSoC Creator 安装目

录中： 

PSoC Creator\psoc\content\CyComponentLibrary\CyComponentLibrary.cylib\CortexM0\IAR 

默认情况下，PSoC Creator 将实例名称“CapSense_1”分配给指定设计中组件的第一个实例。

您可以将其重命名为遵循标识符语法规则的任何唯一值。实例名称会成为每个全局函数名称、变

量和常量符号的前缀。出于可读性考虑，下表中使用的实例名称为“CapSense”。 

通用 API 

以下是将组件置于工作或停止状态的通用 CapSense API 函数： 

函数 说明  

CapSense_Start() 启动组件的首选方法。初始化寄存器，并使能CapSense中所用子组件的活动

模式电源模板位。在Smartsense调试模式中，API根据所计算的寄生电容调整

感应时钟分频、IDAC和分辨率参数。 

CapSense_Stop() 禁用组件中断，并调用CapSense_ClearSensors()，以便将所有传感器复位到

非活动状态。 

CapSense_Sleep() 为进入低功耗模式的器件准备组件。禁用CapSense中所用子组件的活动模式

电源模板位，保存非自保持寄存器并将所有传感器复位到非活动状态。 

CapSense_Wakeup() 当器件从低功耗模式的睡眠模式中唤醒后，还原CapSense配置和非自保持寄

存器值。 

CapSense_Init() 初始化随定制器提供的CapSense默认配置 

CapSense_Enable() 使能CapSense中所用子组件的活动模式电源模板位。 

CapSense_SaveConfig() 保存CapSense配置。  

CapSense_RestoreConfig() 恢复CapSense配置。  
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void CapSense_Start(void) 

说明： 这是开始执行组件操作的首选方法。CapSense_Start()依次调用CapSense_Init()和

CapSense_Enable()函数。初始化寄存器，并启动CapSense组件的CSD方法。将所有传感器

复位到非活动状态。使能传感器扫描中断。选定SmartSense调试模式时，调试过程应用于所

有传感器。在Smartsense调试模式中，API根据所计算的寄生电容调整感应时钟分频、IDAC

和分辨率参数。在调用其他任何API前，必须先调用CapSense_Start()子程序。 

参数： 无 

返回值： 无 

其他影响 如果选择了自动（Smartsense）调试或者自动校准方法，全局中断必须在执行

CapSense_Start()前被使能。  

 

void CapSense_Stop(void) 

说明： 停止传感器扫描、禁用组件中断并将所有传感器复位到非活动状态。禁用CapSense中所用子

组件的活动模式电源模板位。 

参数： 无 

返回值： 无 

其他影响： 应在完成所有扫描操作后调用此函数。 

 

void CapSense_Sleep(void) 

说明： 这是为器件的低功耗模式准备组件的首选方法。禁用CapSense中所用子组件的活动模式电

源模板位。调用CapSense_SaveConfig()函数以保存CapSense的客户配置，并将所有传感

器复位到非活动状态。 

参数： 无 

返回值： 无 

其他影响：  应该在完成扫描操作后调用此函数。 

此函数不能将CapSense组件所使用的引脚置于最低功耗状态。要更改引脚的驱动模式，请

使用引脚分配部分中所述的函数。   
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void CapSense_Wakeup(void) 

说明： 恢复CapSense配置。通过为CapSense中所用的子组件设置活动模式电源模板位，可恢复组

件的启用状态。 

参数： 无 

返回值： 无 

其他影响：  该函数不能将CapSense组件所使用的引脚还原到之前的状态。 

 

void CapSense_Init(void) 

说明： 初始化定义组件操作的定制器所提供的CapSense默认配置。将所有传感器复位到非活动状

态。 

参数： 无 

返回值： 无 

其他影响：  无 

 

void CapSense_Enable(void) 

说明： 使能CapSense中所用子组件的活动模式电源模板位。 

参数： 无 

返回值： 无 

其他影响：  无 

 

void CapSense_SaveConfig(void) 

说明： 保存CapSense的配置。将所有传感器复位到非活动状态。 

参数： 无 

返回值： 无 

其他影响：  应在完成扫描操作后调用此函数。 

此函数不能将CapSense组件所使用的引脚置于最低功耗状态。要更改引脚的驱动模式，请

使用引脚分配部分中所述的函数。  
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void CapSense_RestoreConfig(void) 

说明： 恢复CapSense配置。 

参数： 无 

返回值： 无 

其他影响：  应在完成扫描操作后调用此函数。 

此函数不能将CapSense组件所使用的引脚还原到它们之前的状态。 

 

扫描特定的 API 

以下 API 函数用于执行 CapSense 传感器扫描。 

函数 说明  

CapSense_ScanSensor() 设置扫描设置，然后开始扫描单个传感器或一组传感器。 

CapSense_ScanWidget() 设置扫描设置，然后开始扫描widget。 

CapSense_ScanEnabledWidgets() 首选的扫描方法。扫描所有已启用的Widget。  

CapSense_IsBusy() 返回传感器扫描状态。 

CapSense_SetScanSlotSettings() 设置所选扫描插槽（传感器）的扫描设置。 

CapSense_ClearSensors() 将所有传感器重置到非采样状态。 

CapSense_EnableSensor() 配置所选的传感器，以便在下一个扫描周期中对其进行扫描。 

CapSense_DisableSensor() 禁用所选的传感器，以便在下一个扫描周期内不对其进行扫描。 

CapSense_ReadSensorRaw() 从CapSense_SensorResult[ ]数组返回传感器原始数据。 

CapSense_ReadCurrentScanningSensor() 执行传感器扫描过程中返回扫描的传感器编号。 

 

void CapSense_ScanSensor(uint32 sensor) 

说明： 设置扫描设置，然后开始扫描传感器。扫描完成后，ISR将已测量的传感器原始数据复制到全

局原始感应器阵列中。使用ISR可确保该函数无阻塞。每个传感器在传感器阵列中有唯一编

号。该编号由CapSense定制器依次分配。 

参数： uint8 sensor：传感器编号 

返回值： 无 

其他影响： 无 
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void CapSense_ ScanWidget (uint32 widget) 

说明： 设置扫描设置，然后开始扫描widget。 

参数： uint32 widget：Widget编号。每个Widget都有以下格式的定义： 

#define CapSense_"widget_name"__"widget type"          "Widget 

number" 

示例： 

#define CapSense_TOUCHPAD0__TP                          5 

 

所有Widget名称均为大写。 

返回值： 无 

其他影响： 无 

 

void CapSense_ScanEnabledWidgets(void) 

说明： 这是扫描所有已使能Widget的首选方法。开始对已使能Widget内的传感器进行扫描。ISR对传

感器进行持续扫描，直到所有已使能Widget均扫描完毕。使用ISR可确保该函数无阻塞。  

除接近Widget以外，所有Widget都在默认情况下启用。由于接近Widget的扫描时间较长，不

符合其他类Widget所需的快速响应，因此必须手动启用接近Widget。 

参数： 无 

返回值： 无 

其他影响： 如果未启用任何 Widget，则此次函数调用将无效。 

 

 

uint32 CapSense_IsBusy (void) 

说明： 返回传感器扫描状态。 

参数： 无 

返回值： uint32：返回扫描状态。‘1’ — 正在扫描，‘0’ — 扫描完成。 

其他影响 无 
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void CapSense_SetScanSlotSettings(uint32 slot) 

说明： 对定制器中提供的扫描设置或对所选扫描插槽（传感器）的向导进行设定。这些扫描设置提供

了每个传感器的IDAC值以及分辨率。在一个Widget内，所有传感器的分辨率均相同。 

参数： uint32 slot：扫描插槽编号 

返回值： 无 

其他影响： 无 

 

void CapSense_ClearSensors(void) 

说明： 通过依次断开与Analog MUX Bus（模拟复用器总线）连接的所有传感器并将其连接至非活动

状态，使所有传感器都复位到非采样状态。 

参数： 无 

返回值： 无 

其他影响： 无 

 

void CapSense_EnableSensor(uint32 sensor) 

说明： 配置选定的传感器，以在下一个测量周期中对其进行扫描。将对应引脚设置为Analog HI-Z

（模拟高阻抗模式），并连接至Analog Mux Bus（模拟复用器总线）。这也会影响比较器输

出。 

参数： uint32 sensor：传感器编号 

返回值： 无 

其他影响： 无 

  

void CapSense_DisableSensor(uint32 sensor) 

说明： 禁用所选的传感器。断开与Analog Mux Bus（模拟复用器总线）连接的对应引脚，并将其置

于非活动状态。 

参数： uint32 sensor：传感器编号 

返回值： 无 

其他影响： 无 
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uint16 CapSense_ReadSensorRaw(uint32 sensor) 

说明： 从全局CapSense_SensorResult[ ]数组返回传感器的原始数据。每个扫描传感器在传感器阵列

中有唯一编号。该编号由CapSense定制器依次分配。原始数据可用于执行CapSense所提供

框架以外的计算。 

参数： uint32 sensor：传感器编号 

返回值： uint16：当前的原始数据值 

其他影响： 无 

 

uint32 CapSense_ReadCurrentScanningSensor(void) 

说明： 该API返回正在扫描的传感器ID。如果未扫描任何传感器，API将返回0xFFFFFFFF。 

参数： 无 

返回值： uint32：传感器编号 

其他影响 无 

 

高级 API 

这些 API 函数用于处理传感器 Widget 的原始数据。原始数据可从已扫描的传感器中进行取回，并

转化为按键的开关状态、滑条的位置或触控板的 X 轴和 Y 轴。 

函数 说明  

CapSense_InitializeSensorBaseline() 通过扫描所选传感器，加载含初始值的

CapSense_sensorBaseline[sensor]数组元素。 

CapSense_InitializeEnabledBaselines() 仅通过扫描使能的传感器，才可加载含初始值的

CapSense_sensorBaseline[]数组。  

该函数仅在双通道设计中可用。 

CapSense_InitializeAllBaselines() 通过扫描所有的传感器，加载含初始值的CapSense_sensorBaseline[]

数组。 

CapSense_UpdateSensorBaseline() 针对每个传感器独立计算得出的历史计数值被称为这个传感器的基准

线。更新后的基准线使用“k = 256”的低通滤波器。 

CapSense_UpdateEnabledBaselines() 检查CapSense_sensorEnableMask[]数组并调用

CapSense_UpdateSensorBaseline函数，以更新已使能传感器的基准

线。 

CapSense_EnableWidget() 为扫描过程使能Widget中的所有传感器元件。 

CapSense_DisableWidget() 禁用Widget中所有正处于扫描过程的传感器元件。 
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函数 说明  

CapSense_CheckIsWidgetActive() 将选定的Widget与CapSense_Signal[]数组相比较，以确定其是否存

在手指触摸。  

CapSense_CheckIsAnyWidgetActive() 使用CapSense_CheckIsWidgetActive()函数检查CapSense CSD组件

中是否存在处于活动状态的Widget。 

CapSense_GetCentroidPos() 检查CapSense_sensorSignal[]数组，以确定线性滑条上是否存在手指

触摸，并返回位置。  

CapSense_GetRadialCentroidPos() 检查CapSense_sensorSignal[]数组，以确定辐射滑条上是否存在手指

触摸，并返回位置。  

CapSense_GetTouchCentroidPos() 若有手指存在，则此函数可通过计算触控板内的质心算出该手指在X

轴和Y轴上的位置。 

CapSense_GetMatrixButtonPos() 如有手指触摸，该函数计算矩阵按键上手指的行位置和列位置。 

CapSense_CheckIsSensorActive() 如果传感器处于活动状态，则返回true。 

CapSense_GetBaselineData() 读取传感器基准线。 

CapSense_GetDiffCountData() 返回差值计数数据。 

CapSense_GetNormalizedDiffCountData() 返回标准化的差值计数数据。 

CapSense_GetNoiseThreshold() 返回噪声阈值。 

CapSense_GetNegativeNoiseThreshold() 返回负噪声阈值。 

CapSense_GetNoiseEnvelope() 返回测量的噪声包络线值。 

CapSense_GetFingerThreshold() 返回手指阈值。 

CapSense_GetFingerHysteresis() 返回迟滞值。 

CapSense_WriteSensorRaw() 写入原始计数值。 

CapSense_SetBaselineData() 写入基准线值。 

CapSense_SetSensitivity() 设置灵敏度值。 

CapSense_GetSensitivityCoefficient() 返回K系数。 

Capsense_SetDebounce() 设置去抖动值。 

Capsense_GetDebounce() 返回去抖动值。 

CapSense_SetFingerHysteresis() 设置迟滞值传感器。 

CapSense_SetNoiseThreshold() 设置噪声阈值。 

CapSense_SetNegativeNoiseThreshold() 设置负噪声阈值。 

CapSense_SetLowBaselineReset() 设置低基准线复位阈值。 
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函数 说明  

CapSense_GetLowBaselineReset() 返回低基准线复位阈值。 

CapSense_SetFingerThreshold() 返回手指阈值。 

CapSense_SetDiffCountData() 设置差值计数数据。 

CapSense_GetWidgetNumber() 返回传感器的widget编号。 

CapSense_UpdateThresholds() 更新阈值。 

CapSense_UpdateBaselineNoThreshold() 更新基准线而不更新阈值。 

CapSense_SetIDACRange() 设置IDAC范围。 

CapSense_GetIDACRange() 返回IDAC范围。 

CapSense_SetModulationIDAC()  设置调制IDAC的值。 

CapSense_GetModulationIDAC() 返回调制IDAC的值。 

CapSense_SetCompensationIDAC()  设置补偿IDAC的值。 

CapSense_GetCompensationIDAC()  返回补偿IDAC的值。 

CapSense_SetSenseClkDivider() 设置感应时钟分频器的值。 

CapSense_GetSenseClkDivider() 返回感应时钟分频器的值。 

CapSense_SetModulatorClkDivider() 设置调制采样时钟分频器的值。 

CapSense_GetModulatorClkDivider()  返回调制采样时钟分频器的值。 

CapSense_SetScanResolution()  设置传感器扫描分辨率的值。 

CapSense_GetScanResolution()  返回传感器扫描分辨率的值。 

CapSense_SetAllDriveModes() 设置端口引脚的驱动模式。 

CapSense_RestoreAllDriveModes() 将所有CapSense端口引脚的驱动模式恢复到原始状态。 

CapSense_SetUnscannedSensorState() 设置未扫描传感器的状态。 

 

void CapSense_InitializeSensorBaseline(uint32 sensor) 

说明： 通过扫描所选传感器，加载含初始值的CapSense_sensorBaseline[sensor]数组元素。将原始

计数值复制到每个传感器的基准线数组中。初始化原始数据滤波器（如果已启用）。 

参数： uint32 sensor：传感器编号 

返回值： 无 

其他影响： 无 
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void CapSense_InitializeEnabledBaselines(void) 

说明： 扫描所有已启用的Widget。对于扫描过程中启用的所有传感器，原始计数值被复制到

CapSense_sensorBaseline[ ]数组。对扫描过程禁用的传感器，用零值初始化

CapSense_sensorBaseline[ ]。初始化原始数据滤波器（如果已启用）。 

 

参数： 无 

返回值： 无 

其他影响： 

 

无 

 

void CapSense_InitializeAllBaselines(void) 

说明： 使用CapSense_InitializeSensorBaseline()函数扫描所有传感器，以加载含初始值的

CapSense_sensorBaseline[ ]数组。将原始计数值复制到所有传感器的基准线数组中。初始化

原始数据滤波器（如果已启用）。 

参数： 无 

返回值： 无 

其他影响： 无 

 

void CapSense_UpdateSensorBaseline(uint32 sensor) 

说明： 传感器的基准线是针对每个传感器独立计算得出的历史计数值。使用“k = 256”的低通滤波

器更新CapSense_sensorBaseline[sensor]数组元素。该函数通过将之前的基准线从当前原始

计数值中扣除并将其存储在CapSense_sensorSignal[sensor]中，来计算差值计数。  

如果启用自动复位选项，则基准线将被更新，而不受噪声阈值的影响。  

如果自动复位选项被禁用，则在信号值大于噪声阈值的情况下，基准线将会停止更新，而在信

号值小于负的噪声阈值的情况下，该基准线将会复位。 

若原始数据滤波器在计算基准线之前启用，则可应用于这些数值。 

参数： uint32 sensor：传感器编号 

返回值： 无 

其他影响： 无 
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void CapSense_UpdateEnabledBaselines(void) 

说明： 检查CapSense_sensorEnableMask[]数组并调用CapSense_UpdateSensorBaseline()函数，

以更新所有已使能传感器的基准线。 

参数： 无 

返回值： 无 

其他影响： 无 

 

void CapSense_EnableWidget(uint32 widget) 

说明： 使能所选的Widget传感器，以作为扫描过程中的一部分。 

参数： uint32 widget：Widget编号。每个Widget都有以下格式的定义： 

#define CapSense_"widget_name"__"widget type"            5 

示例： 

#define CapSense_MY_VOLUME1__LS                          5 

#define CapSense_MY_UP__BNT                              6 

所有Widget名称均为大写。 

返回值： 无 

其他影响： 无 

 

void CapSense_DisableWidget(uint32 widget) 

说明： 禁用所有扫描过程中选定的Widget传感器。 

参数： uint32 widget：Widget编号。每个Widget都有以下格式的定义： 

#define CapSense_"widget_name"__"widget type"            5 

示例： 

#define CapSense_MY_VOLUME1__RS                          5 

#define CapSense_MY_UP__MB                               6 

所有Widget名称均为大写。 

返回值： 无 

其他影响： 无 
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uint32 CapSense_CheckIsWidgetActive(uint32 widget) 

说明： 将选定的传感器CapSense_Signal[ ]数组值与其手指阈值进行比较。考虑了迟滞和去抖动。若

传感器处于活动状态，则迟滞量会降低阈值。若传感器处于非活动状态，则迟滞量会提高阈

值。若满足活动阈值，则去抖动计数器会增加一，直至传感器达到有效切换，此时该API将

Widget设置为活动状态。此函数还更新传感器CapSense_sensorOnMask[ ]数组中的位。 

触控板和矩阵按键Widget需要在行和列中都拥有处于活动状态的传感器，以返回Widget活动状

态。 

参数： uint32 widget：Widget编号。每个Widget都有以下格式的定义： 

#define CapSense_"widget_name"__"widget type"            5 

示例： 

#define CapSense_MY_VOLUME1__LS                          5 

所有Widget名称均为大写。 

返回值： uint32：Widget传感器状态。如果Widget内有一个或多个传感器处于活动状态，则计为1，如

果Widget内所有的传感器均处于非活动状态，则计为0。 

其他影响 此函数还更新从属于Widget的所有传感器的CapSense_sensorOnMask[ ]值。如果转换至活动

状态，则每次调用时还会修改去抖动计数器。 

 

uint32 CapSense_CheckIsAnyWidgetActive(void) 

说明： 将CapSense_Signal[ ]数组中的所有传感器与其手指阈值进行比较。针对每个Widget调用

Capsense_CheckIsWidgetActive()，以便在调用此函数后，CapSense_sensorOnMask[ ]数组

为最新。 

参数： 无 

返回值： uint32：如有Widget处于活动状态则计为1，如果没有Widget处于活动状态则计为0。 

其他影响 和CapSense_CheckIsWidgetActive()函数具有同样的其他影响，但并非针对所有传感器。 
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uint16 CapSense_GetCentroidPos(uint32 widget) 

说明： 检查CapSense_Signal[ ]数组在线性滑条内是否存在手指触摸。将手指位置计算为CapSense

定制器中指定的API分辨率。位置滤波器（如果已使能）将应用于该结果中。仅在CapSense

定制器定义了线性滑条Widget 时，才能使用此函数。 

参数： uint32 widget：Widget编号。每个线性滑条Widget都有以下格式的定义： 

#define CapSense_"widget_name"__LS            5 

示例： 

#define CapSense_MY_VOLUME1__LS               5 

所有Widget名称均为大写。 

返回值： uint16：线性滑条的位置数值 

其他影响： 如果滑条Widget内有任何传感器处于活动状态，则函数将数值从零返回至CapSense定制器中

设置的API分辨率值。如果没有任何传感器处于活动状态，则该函数返回0xFFFF。如果在执行

质心/双工算法时出现错误，则该函数返回0xFFFF。 

没有为此函数提供Widget参数检查。不正确的Widget值可导致意外的位置计算结果。 

注意：如果滑条段的噪声计数大于噪声阈值，则此子例程可能生成假的手指触摸结果。设置噪

声阈值时应小心（显著大于噪声级别），以便噪声不会产生假的手指触摸。 

 

uint16 CapSense_GetRadialCentroidPos(uint32 widget) 

说明： 检查CapSense_Signal[ ]数组在辐射滑条内是否存在手指触摸。将手指位置计算为CapSense

定制器中指定的API分辨率。位置滤波器（如果已使能）将应用于该结果中。仅在CapSense

定制器定义了辐射滑条Widget时，才能使用此函数。 

参数： uint32 widget：Widget编号。每个辐射滑条Widget都有以下格式的定义： 

#define CapSense_"widget_name"__RS            5 

示例： 

#define CapSense_MY_VOLUME2__RS               5 

所有Widget名称均为大写。 

返回值： uint16：辐射滑条的位置数值。 

其他影响： 如果滑条Widget内有任何传感器处于活动状态，则函数将数值从零返回至CapSense定制器中

设置的API分辨率值。如果没有任何传感器处于活动状态，则该函数返回0xFFFF。 

没有为此函数提供Widget类型参数检查。不正确的Widget值可导致意外的位置计算结果。 

注意：如果滑条段的噪声计数大于噪声阈值，则此子例程可能生成假的手指触摸结果。设置噪

声阈值时应小心（显著大于噪声级别），以便噪声不会产生假的手指触摸。 

 



PSoC 4 Capacitive Sensing (CapSense® CSD) PSoC
®
 Creator™ Component Datasheet 

页 62/95 Document Number: 001-92183 Rev. **  

uint32 CapSense_GetTouchCentroidPos(uint32 widget, uint16* pos) 

说明： 如果触控板上有手指触摸，则此函数可通过计算触控板传感器内的质心来计算手指在X轴和Y

轴上的位置。手指在X轴和Y轴上的位置根据CapSense定制器中设置的API分辨率进行计算。

如果触控板上存在手指触摸，则返回‘1’。位置滤波器（如果已使能）将应用于该结果中。

仅在CapSense定制器定义了触控板时，才能使用此函数。 

参数： uint8 widget：Widget编号。每个触控板Widget都有以下格式的定义： 

#define CapSense_"widget_name"__TP            5 

示例： 

#define CapSense_MY_TOUCH1__TP                5 

所有Widget名称均为大写。 

(uint16* pos): pointer to an array of two uint16, where touch 

postion will be stored: 

    pos[0] - X position; 

    pos[1] - Y position. 

 

返回值： uint32：如果触控板上存在手指触摸，返回值为1。不存在手指触摸时，则返回值为0。 

其他影响  

 

uint32 CapSense_GetMatrixButtonPos(uint32 widget, uint8* pos) 

说明： 如果触摸了矩阵按键，该函数会计算手指的行位置和列位置。如果触摸了矩阵按键，则返回一

个‘1’值。仅在CapSense定制器定义了矩阵按键时，该函数才可用。 

参数： uint8 widget：Widget编号。每个矩阵按键Widget都有以下格式的定义： 

#define CapSense_"widget_name"__MB            5 

示例： 

#define CapSense_MY_TOUCH1__MB                5 

所有Widget名称均为大写。 

(uint8* pos): pointer to an array of two uint8, where touch 

postion will be stored: 

    pos[0] - column position; 

    pos[1] - row position. 

 

返回值： uint8：如果触控板上存在手指触摸，返回值为1。不存在手指触摸时，则返回值为0。 

其他影响  
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uint32 CapSense_CheckIsSensorActive(uint32 sensor) 

说明： 将选定的传感器CapSense_sensorSignal[ ]数组值与其手指阈值进行比较。需要考虑到迟滞和

去抖动。根据传感器当前是否开启，对手指阈值增加或消减迟滞值。若传感器处于活动状态，

则迟滞量会降低阈值。若传感器处于非活动状态，则迟滞量会提高阈值。为传感器活动的瞬变

增加了去抖动计数器。此函数还更新传感器CapSense_sensorOnMask[ ]数组中的位。 

参数： uint32 – sensor：传感器编号 

返回值： uint32：如果扫描传感器处于活动状态，返回值为1；如果扫描传感器处于非活动状态，则返

回值为0。 

其他影响 此函数还更新传感器CapSense_sensorOnMask[ ]数组中的位。 

 

uint16 CapSense_GetBaselineData(uint32 sensor) 

说明： 这是读取组件内的传感器基准线的函数。 

参数： uint32 sensor：传感器索引 

返回值： uint16：该API返回参数表示的传感器基准线值。 

其他影响 无 

 

uint16 CapSense_GetDiffCountData(uint32 sensor) 

说明： 如果跳频被禁用，该API将返回差值计数数据；如果跳频被使能，该API将返回中值滤波器差值

计数数据（三个跳频通道的中值）。  

参数： uint32 sensor：传感器索引 

返回值： uint16：该API返回参数表示的差值计数值。 

其他影响 无 

 

uint16 CapSense_GetNormalizedDiffCountData(uint32 sensor) 

说明： 如果跳频被禁用，该API将返回标准化的差值计数数据；如果跳频被使能，该API将返回中值滤

波器差值计数数据（三个跳频通道的中值）。 

参数： uint32 sensor：传感器索引 

返回值： uint16：该API返回参数表示的标准化差值计数值。 

其他影响 无 
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uint8 CapSense_GetNoiseThreshold(uint32 widget) 

说明： 该API返回噪声阈值。 

参数： uint32 widget：Widget索引 

返回值： uint8：该API返回参数表示的widget的噪声阈值。 

其他影响 无 

 

uint8 CapSense_GetNegativeNoiseThreshold(uint32 widget) 

说明： 该 API返回负噪声阈值。 

参数： uint32 widget：Widget索引 

返回值： uint8：该API返回参数表示的widget的负噪声阈值。 

其他影响 无 

 

uint16 CapSense_GetNoiseEnvelope(uint32 sensor) 

说明： 该API返回测量的噪声包络线值。该API的最小值为1，并且它从不会返回0（如噪声）。  

仅在SmartSense （自动调试）被使能时，该API才可用。  

参数： uint32 sensor：传感器索引 

返回值： uint16：该API返回参数表示的传感器的噪声包络线值。 

其他影响 无 

 

uint8/uint16 CapSense_GetFingerThreshold(uint32 widget) 

说明： 该API返回手指阈值。  

参数： uint32 widget：Widget索引 

返回值： uint8/uint16：该API返回参数表示的widget手指阈值。 

其他影响 无 

 

uint8 CapSense_GetFingerHysteresis(uint32 widget) 

说明： 该API返回迟滞值。  

参数： uint32 widget：Widget索引 

返回值： uint8：该API返回参数表示的widget迟滞。 

其他影响 无 
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void CapSense_WriteSensorRaw(uint32 sensor, uint16 data) 

说明： 该API包括两个参数：传感器编号和原始计数值。该API将参数通过的原始计数值写入到传感器

原始计数陈列中。 

参数： uint32 sensor：传感器索引 

uint16 data：传感器原始计数。 

返回值： 无 

其他影响： 无 

 

void CapSense_SetBaselineData(uint32 sensor, uint16 data) 

说明： 该API包括两个参数：传感器编号和基准线值。  

该API将参数通过的数据值写入到传感器基准线陈列中。 

参数： uint32 sensor：传感器索引 

uint16 data：传感器基准线。 

返回值： 无 

其他影响： 无 

 

void CapSense_SetSensitivity(uint32 sensor, uint32 data) 

说明： 该API设置传感器的灵敏度值。 灵敏度值使用于在CapSense_Start API中执行的自动调试算法

。 

调用CapSense_Start API前，该API由应用层调用。执行CapSense_Start API后调用该API将

不产生任何影响。 

参数： uint32 sensor：传感器索引 

uint32 data：传感器的灵敏度。可能值为： 

灵敏度为1 – 0.1 pF 

灵敏度为2 – 0.2 pF 

灵敏度为3 – 0.3 pF 

灵敏度为4 – 0.4 pF 

对于所有其他的值，将灵敏度值设置为0.4 pF。 

返回值： 无 

其他影响： 无 
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uint32 CapSense_GetSensitivityCoefficient(uint32 sensor) 

说明： 该API为相应的传感器返回K系数。 

参数： uint32 sensor：传感器索引 

返回值： uint32：相应传感器的K值。 

其他影响 无 

 

void Capsense_SetDebounce(uint32 widget, uint8 value) 

说明： 该API设置去抖动值。该API对widget内的所有传感器产生影响。 

参数： uint32 widget：Widget编号。 

uint8 value：去抖动值  

返回值： 无 

其他影响： 无 

 

uint8 Capsense_GetDebounce(uint32 widget) 

说明： 该API返回去抖动值。 

参数： uint32 widget：Widget编号。 

返回值： uint8：返回去抖动值。  

其他影响 无 

 

void CapSense_SetFingerHysteresis(uint32 widget, uint8 value) 

说明： 该API设置迟滞值传感器。该API对widget内的所有传感器产生影响。 

参数： uint32 widget：Widget编号。 

uint8 value：迟滞值。 

返回值： 无 

其他影响： 无 
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void CapSense_SetNoiseThreshold(uint32 widget, uint8 value) 

说明： 该API设置widget内所有传感器的噪声阈值。  

参数： uint32 widget：Widget编号。 

uint8 value：噪声阈值。  

返回值： 无 

其他影响： 无 

 

void CapSense_SetNegativeNoiseThreshold(uint32 widget, uint8 value) 

说明： 该API设置widget的负噪声阈值。该API对widget内的所有传感器产生影响。 

参数： uint32 widget：Widget编号。 

uint8 value：负噪声阈值。 

返回值： 无 

其他影响： 无 

 

void CapSense_SetLowBaselineReset(uint32 sensor, uint8 value) 

说明： 该API设置传感器的低基准线复位阈值。 

参数： uint32 widget：Widget编号。 

uint8 value：低基准线复位阈值。  

返回值： 无 

其他影响： 无 

 

uint8 CapSense_GetLowBaselineReset(uint32 sensor) 

说明： 该API返回传感器的低基准线复位阈值。 

参数： uint32 widget：Widget编号。 

返回值： uint8：返回低基准线复位阈值。  

其他影响 无 
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void CapSense_SetFingerThreshold(uint32 widget, uint8/16 value) 

说明： 该API设置Widget的手指阈值。 

参数： uint32 widget：Widget编号。 

uint8/16 value：Widget的手指阈值。 

返回值： 无 

其他影响： 无 

 

void CapSense_SetDiffCountData(uint32 sensor, uint16/uint8 value) 

说明： 该API设置每个传感器的差值计数数据。  

参数： uint32 sensor：传感器索引 

uint16/uint8 value：差值计数数据。  

返回值： 无 

其他影响： 无 

 

uint32 CapSense_GetWidgetNumber(uint32 sensor) 

说明： 该API返回传感器的widget编号。 

参数： uint32 sensor：传感器索引。 索引值的范围是从0到N。N值可以是0到传感器总数减1。 

返回值： uint32:：返回传感器的widget编号。 

其他影响 无 

 

void CapSense_UpdateThresholds(uint32 sensor) 

说明： 当SmartSense被使能时，该API将计算给定传感器的阈值参数，并对存储每个传感器的阈值参

数的相应数组/变量进行参数更新。有两个可能的方法能够计算上面所述的阈值。 

当自动阈值被使能，该API将根据传感器的测量噪声包络线计算阈值参数。在此模式下，API将

计算给定传感器的手指阈值和其他阈值。 

当自动阈值被禁用时，该API将不计算手指阈值。此时，手指阈值应由应用固件设置的。该API

可以根据调用方设置的手指阈值计算所有其他阈值。在此模式下，调用该API前，API会预期调

用方设置相应的手指阈值。 

该API适用于所有传感器类型。  

参数： uint32 sensor：传感器索引。索引值的范围是从0到N。N值可以是0到传感器总数减1。 

返回值： 无 

其他影响： 无 

 



PSoC
®
 Creator™ Component Datasheet PSoC 4 Capacitive Sensing (CapSense® CSD) 

Document Number: 001-92183 Rev. ** 页 69/95 

void CapSense_UpdateBaselineNoThreshold(uint32 sensor) 

说明： 该API更新了给定传感器的基准线。该API不计算或修改给定传感器相关的阈值参数。  

参数： uint32 sensor：传感器索引。索引值的范围是从0到N。N值可以是0到传感器总数减1。 

返回值： 无 

其他影响 传感器基准线变量将被更新。 

 

void CapSense_SetIDACRange(uint32 iDacRange) 

说明： 将IDAC范围设置为4x (1.2uA/位)或8x (2.4uA/位)模式。IDAC范围对于所有传感器和调制以及

补偿IDAC很常用。 

参数： uint32 iDacRange：表示IDAC范围的值。  

0 - IDAC范围被设置为4x (1.2uA/位) 

1或>1 - IDAC范围被设置为8x (2.4uA/位) 

返回值： 无 

其他影响： 无 

 

uint32 CapSense_GetIDACRange(void) 

说明： 返回表示IDAC范围的值。组件采用该范围来扫描传感器。 IDAC对于所有传感器通用。 

参数： 无 

返回值： uint32 iDacRange：表示IDAC范围的值。  

0 - IDAC范围被设置为4x (1.2uA/位) 

1或>1 - IDAC范围被设置为8x (2.4uA/位) 

其他影响 无 

 

void CapSense_SetModulationIDAC(uint32 sensor, uint32 modIdacValue) 

说明： 设置传感器的调制IDAC值。 

参数： uint32 sensor：传感器索引。  

uint32 modIdacValue：表示调制IDAC数据寄存器值。 

返回值： 无 

其他影响： 无 
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uint32 CapSense_GetModulationIDAC(uint32 sensor) 

说明： 返回传感器的调制IDAC值。 

参数： uint32 sensor：传感器索引。 

返回值： uint32：返回调制IDAC数据寄存器值。 

其他影响 无 

 

void CapSense_SetCompensationIDAC(uint32 sensor, uint32 compIdacValue) 

说明： 设置传感器的调制IDAC值。 

参数： uint32 sensor：传感器索引。 

uint32 compIdacValue：表示补偿IDAC数据寄存器值。  

返回值： 无 

其他影响： 无 

 

uint32 CapSense_GetCompensationIDAC(uint32 sensor) 

说明： 返回传感器的补偿IDAC值。 

参数： uint32 sensor：传感器索引。 

返回值： uint32：返回补偿IDAC数据寄存器值。  

其他影响 无 

 

void CapSense_SetSenseClkDivider(uint32 sensor, uint32 senseClk) 

说明： 设置传感器的感应时钟分频器值。 

参数： uint32 sensor：传感器索引。  

uint32 senseClk：表示感应时钟值。 

返回值： 无 

其他影响： 无 
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uint32 CapSense_GetSenseClkDivider(uint32 sensor) 

说明： 返回传感器的感应时钟分频器值。 

参数： uint32 sensor：传感器索引。 

返回值： uint32：返回传感器的感应时钟分频器值。  

其他影响 无 

 

void CapSense_SetModulatorClkDivider(uint32 sensor, uint32 modulatorClk) 

说明： 设置传感器的调制采样时钟分频器值。 

参数： uint32 sensor：传感器索引。 

uint32 – modulatorClk：表示调制采样时钟的值。 

返回值： 无 

其他影响： 无 

 

uint32 CapSense_GetModulatorClkDivider(uint32 sensor) 

说明： 返回传感器的调制采样时钟分频器的值。 

参数： uint32 sensor：传感器索引。 

返回值： uint32：返回传感器的调制采样时钟分频器的值。 

其他影响 无 

 

void CapSense_SetScanResolution(uint32 widget, uint32 resolution) 

说明： 设置widget的传感器扫描分辨率的值。  

参数： uint32 widget：widget索引。  

uint32 resolution：表示分辨率值。  

返回值： 无 

其他影响： 无 
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uint32 CapSense_GetScanResolution(uint32 widget) 

说明： 返回widget的分辨率值。 

参数： uint32 widget：widget索引。 

返回值： uint32：返回widget的分辨率。 

其他影响 无 

 

void CapSense_SetDriveModeAllPins(uint32 driveMode) 

说明： 该API将CapSense组件（传感器、保护、屏蔽、屏蔽槽和Cmod）使用的端口引脚的驱动模式

设置为参数表示的驱动模式。 

参数： uint32 driveMode：是表示驱动模式的参数。 

值： 

CY_SYS_PINS_DM_ALG_HIZ — 高阻抗模拟 

CY_SYS_PINS_DM_DIG_HIZ — 高阻抗数字 

CY_SYS_PINS_DM_RES_UP — 电阻上拉 

CY_SYS_PINS_DM_RES_DWN — 电阻下拉 

CY_SYS_PINS_DM_OD_LO — 开漏，驱动低电平 

CY_SYS_PINS_DM_OD_HI — 开漏，驱动高电平 

CY_SYS_PINS_DM_STRONG — 强驱动 

CY_SYS_PINS_DM_RES_UPDWN — 电阻上/下拉 

返回值： 无 

其他影响 仅在停止CapSense组件后，才应调用该API。 

 

void CapSense_RestoreDriveModeAllPins(void) 

说明： 该API将所有CapSense端口引脚的驱动模式恢复到原始状态。 该API是

CapSense_SetDriveModeAllPins API的补充部分。 

参数： 无 

返回值： 无 

其他影响： 无 
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void CapSense_SetUnscannedSensorState(uint32 sensor, uint32 sensorState) 

说明： 该API设置未扫描传感器的状态。 可以将状态设置为接地、高阻或屏蔽电极状态。如果屏蔽被

使能，可以将未扫描的传感器连接至屏蔽电极。如果屏蔽被禁用，以及该API由表示屏蔽状态

的参数调用，那么，未扫描的传感器将被连接至地。 

参数： uint32 sensor：该参数表示传感器ID。 

uint32 sensorState：该参数表示未扫描传感器的状态。 

值： 

CapSense__GROUND 0 

CapSense__HIZ_ANALOG 1 

CapSense__SHIELD 2 

返回值： 无 

其他影响 仅在停止CapSense组件后，才应调用该API。 

 

调谐器助手 API 

这些 API 函数与调谐器 GUI 一起使用 。 

函数 说明  

CapSense_TunerStart() 初始化CapSense CSD和内部通信组件，初始化基准线并启动传感器扫描

循环。 

CapSense_TunerComm() 执行调谐器GUI之间的通信。 

 

void CapSense_TunerStart(void) 

说明： 初始化CapSense CSD和内部通信组件。  

除接近Widget以外，所有Widget都在默认情况下使能。由于接近Widget的扫描时间较长，不

符合其他类Widget所需的快速响应，因此必须手动启用接近Widget。 

参数： 无 

返回值： 无 

其他影响 如果选择了自动（Smartsense）调试或者自动校准方法，全局中断要在执行

CapSense_TunerStart()前被使能。 
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void CapSense_TunerComm(void) 

说明： 执行与调谐器GUI之间的通信功能。 

 手动模式：将传感器扫描和 Widget 处理结果从 CapSense CSD 组件传输到调谐器 GUI。

从调谐器 GUI 读取新参数并将其应用于 CapSense CSD 组件。 

 自动（SmartSense）：执行与调谐器 GUI 之间的通信功能。将传感器扫描和 Widget 处理

结果传输到调谐器 GUI。自动调试参数也传输到调谐器 GUI。调谐器 GUI 参数不会被传输

回 CapSense CSD 组件。 

此函数正在执行阻塞操作，并等待调谐器GUI修改CapSense CSD组件缓冲区以允许新数据。  

参数： 无 

返回值： 无 

其他影响： 无 

 

内置自检 API 

这些 API 函数用于检查准确的硬件设置（如 Cmod）、寄生电容、屏蔽电极和外部屏蔽槽电容。 

功能 说明  

CapSense_GetSensorCp() 返回传感器的寄生电容。 

CapSense_MeasureCmod() 测量以单位为pF的CMOD外部电容器。 

CapSense_MeasureCShield() 测量屏蔽电极的电容值。 

CapSense_MeasureCShieldTank() 测量外部屏蔽槽电容器的电容值。 

 

uint32 CapSense_GetSensorCp(uint32 sensor) 

说明： 该API返回传感器的Cp（寄生电容）（单位为pF）。 

参数： uint32 sensor：传感器索引  

返回值： uint32:该API返回参数表示的传感器的传感器寄生电容（Cp）。传感器Cp值的单位为皮法。 

其他影响 无 
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uint32 CapSense_MeasureCmod(void) 

说明： 该API测量CMOD外部电容器（单位为pF）。  

参数： 无 

返回值： uint32：返回测量的CMOD（单位为皮法）。 

其他影响 调用该API前应该停止CSD组件。 

 

uint32 CapSense_MeasureCShield(void) 

说明： 该API实行测量屏蔽电极的电容值方法。 调用该API时，它将返回单位为皮法的屏蔽电极电

容。 

参数： 无 

返回值： uint32：返回屏蔽电极的测量电容，单位为皮法。 

其他影响 调用该API前应该停止CSD组件。 

 

uint32 CapSense_MeasureCShieldTank(void) 

说明： 该API实行测量外部屏蔽槽电容器的电容值方法。调用该API时，它将返回屏蔽槽电容，单位为

皮法。 

参数： 无 

返回值： uint32：返回屏蔽槽电容器的测量电容，单位为皮法。 

其他影响 调用该API前应该停止CSD组件。 

 

数据结构 

API 函数使用几种全局数组来处理传感器和 Widget 数据。不得手动更改这些数组。可以出于调试

和调试目的对这些值进行查看。例如，可以使用绘图工具显示数组的内容。全局数组为： 

数组  说明  

CapSense_sensorRaw[] 此数组包含每个传感器的原始数据。数组大小等于传感器总数

(CapSense_TOTAL_SENSOR_COUNT)。CapSense_sensorRaw[ ]数据通过

以下函数更新：  

 CapSense_ScanSensor() 

 CapSense_ScanEnabledWidgets() 

 CapSense_InitializeSensorBaseline() 

 CapSense_InitializeAllBaselines() 

 CapSense_UpdateEnabledBaselines() 
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数组  说明  

CapSense_sensorEnableMask[] 这是一个保持传感器扫描状态的字节数组CapSense_sensorEnableMask[0]，

包含传感器0到7的掩码位（传感器0为0位，传感器1为1位）。

CapSense_sensorEnableMask[1] 包含传感器8到15的掩码位（如果需要），

以此类推。此字节数组存储的元件数足以包含所有的传感器。位值指定是否通

过CapSense_ScanEnabledWidgets()函数调用对传感器进行扫描：1 — 传感

器被扫描，0 — 传感器不被扫描。CapSense_sensorEnableMask[ ]数据通过

以下函数进行更改： 

 CapSense_EnabledWidget() 

 CapSense_DisableWidget() 

 CapSense_sensorEnableMask[ ]数据为以下函数所用： 

 CapSense_ScanEnabledWidgets() 

CapSense_portTable[] and 
CapSense_maskTable[] 

这些数组包含每个传感器的端口和引脚掩码，以指定传感器连接的引脚。  

 端口 — 定义引脚所属的端口号。 

 掩码 — 定义端口内的引脚号。 

CapSense_sensorBaselineLow[] 此数组存储低通滤波器中所使用每个传感器的基准线数据分数字节，用于基准

线更新。数组大小等于传感器总数。CapSense_sensorBaselineLow[ ]数组通

过以下函数更新：  

 CapSense_InitializeSensorBaseline() 

 CapSense_InitializeAllBaselines() 

 CapSense_UpdateSensorBaseline() 

 CapSense_UpdateEnabledBaselines() 

CapSense_sensorBaseline[] 此数组存储每个传感器的基准线数据。数组大小等于传感器总数。

CapSense_sensorBaseline[ ]数组通过以下函数更新：  

 CapSense_InitializeSensorBaseline() 

 CapSense_InitializeAllBaselines() 

 CapSense_UpdateSensorBaseline() 

 CapSense_UpdateEnabledBaselines(). 

CapSense_sensorSignal[] 此数组存储通过从每个传感器的当前原始数据中减去以前的基准线计算而来的

传感器信号数据。数组大小等于传感器总数。Widget分辨率参数将此数组的分

辨率定义为1字节或2字节。CapSense_sensorSignal[ ]数组通过以下函数更新

：  

 CapSense_InitializeSensorBaseline() 

 CapSense_InitializeAllBaselines() 

 CapSense_UpdateSensorBaseline() 

 CapSense_UpdateEnabledBaselines(). 
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数组  说明  

CapSense_sensorOnMask[] 这是uint8数组，可保持（按键、矩阵按键或滑条）传感‘on’（活动）或

‘off’（非活动）状态。CapSense_sensorOnMask[0]包含传感器0到7的掩码

位（传感器0为0位，传感器1为1位）。CapSense_sensorOnMask[1]包含传感

器8到15的掩码位（如果需要），依次类推。uint8数组包含的元素数足以包含

所有放置的传感器。如果传感器开启，则位值为1；如果传感器关闭，则位值

为0。  

CapSense_ModulatorIDAC[] 此数组包含了每个传感器的8位IDAC值。数组大小等于传感器总数。  

CapSense_CompensationIDAC[] 此数组包含了每个传感器的7位IDAC值。数组大小等于传感器总数。  

CapSense_senseClkDividerVal[] 此数组包含每个传感器的感应时钟。仅在定制器中使能单一频率设置时，才会

生成此数组。 

CapSense_sampleClkDividerVal[] 此数组包含每个传感器的调制时钟分频器。仅在定制器中使能单一频率设置

时，才会生成此数组。 

CapSense_rawFilterData1[] 此数组用于存储任何已使能的原始数据滤波器的之前样本。 

CapSense_rawFilterData1[ ]数据通过以下函数进行更新： 

 CapSense_UpdateSensorBaseline() 

CapSense_rawFilterData2[] 此数组用于存储使能的原始数据滤波器的之前样本。它仅用于中值或均值滤波

器（这些滤波器也使用CapSense_rawFilterData1数组存储之前的样本）。 

CapSense_rawFilterData2[ ]数据通过以下函数进行更新： 

 CapSense_UpdateSensorBaseline() 

CapSense_lowBaselineResetCnt[] 将此函数的元素作为计数器使用，可以决定应不应该对每个扫描传感器进行基

准线复位。如果差值信号为负向并高于

CapSense_NEGATIVE_NOISE_THRESHOLD，那么计数器会进行递增计

数。当计数器达到CapSense_LOW_BASELINE_RESET值，则对传感器的基

准线进行重新初始化，同时，也将计数器设为零。The 

CapSense_lowBaselineResetCnt[ ]数据通过以下函数进行更新： 

 CapSense_UpdateSensorBaseline() 

CapSense_fingerThreshold[] 此数组包含用于确定是否发生触摸的每个传感器上的信号电平。 

CapSense_noiseThreshold[] 此数组包含每个传感器的确定电容扫描中的噪声等级的信号等级。低于阈值的

噪声用于更新传感器的基准线。相反，高于阈值的噪声不用于更新基准线。 

CapSense_hysteresis[] 此数字包含每个Widget的迟滞值。 

CapSense_debounceCounter[]数据通过以下函数进行更新： 

 CapSense_CalculateThresholds() 
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数组  说明  

CapSense_debounce[] 此数组包含每个Widget中去抖动特性的去抖动值。为包含此参数的各Widget设

置该去抖动值。这些Widget包括：按键、矩阵按键、接近传感器和保护传感

器。所有其他widget没有去抖动参数，并使用此数组中值为0的最后元素（0表

示“无去抖动”）。CapSense_debounce[]数组用于初始化

CapSense_debounceCounter[]数组。 

CapSense_debounceCounter[] 此数组包含某个传感器的当前去抖动值。如果该传感器处于活动状态（即传感

器信号的值大于手指阈值与迟滞之和），那么计数器将进行递减计数。当它达

到1时，将设置传感器ON掩码（CapSense_sensorOnMask），同时，将计数

器的值复位为CapSense_debounce[]数组的默认值。当传感器处于非活动状态

（触摸解放），以及传感器信号的值低于手指阈值与迟滞值之差，计数器的行

为也会相同。通过CapSense_CheckIsSensorActive()函数执行此功能。 

CapSense_debounceCounter[]数据通过以下函数进行更新： 

 CapSense_BaseInit() 

 CapSense_CheckIsSensorActive() 

 

常量 

以下常量已进行定义。一些常量有条件地进行定义，且仅在当前配置需要时才会显示。 

 CapSense_TOTAL_SENSOR_COUNT — 规定 CapSense CSD 组件内传感器的总数。 

传感器常量 

每个传感器均提供一个常量。可在以下函数中将这些常量作为参数使用： 

 CapSense_EnableSensor() 

 CapSense_DisableSensor() 

常量名称由以下内容组成： 

实例名称 + “_SENSOR” + Widget 名称 + 元件 + "#元件号" + “__” + Widget 类型 

例如： 

#define CapSense_SENSOR_TP1_ROW0__TP    0 

#define CapSense_SENSOR_TP1_ROW1__TP    1 

#define CapSense_SENSOR_TP1_COL0__TP    2 

#define CapSense_SENSOR_TP1_COL0__TP    3 

#define CapSense_SENSOR_LS0_E0__LS      5 

#define CapSense_SENSOR_LS0_E1__LS      6 

#define CapSense_SENSOR_PROX1__PROX     7 
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 Widget 名称 — 用户定义的 Widget 名称（必须为有效“C”式标识符）。Widget 名称必须

在 CapSense CSD 组件中唯一。所有 Widget 名称均为大写。 

 元件号 — 只有包含多个元件的“Widget”（如辐射滑条）才有元件号。对于触控板及矩阵

按键，元件号由“Col”或“Row”及其编号组成（如：Col0、Col1、Row0、Row1）。对

于线性滑条及辐射滑条，元件号由字母“e”及其编号组成（如：e0、e1、e2、e3）。 

 Widget 类型 — 存在多种 Widget 类型： 

别名 说明  

BTN 按键 

LS 线性滑条 

RS 辐射滑条 

TP 触控板 

MB 矩阵按键 

PROX 接近传感器 

GEN 通用传感器 

GRD 保护传感器 

 

Widget 常量 

为每个 Widget 提供一个常量。可在以下函数中将这些常量作为参数使用： 

 CapSense_CheckIsWidgetActive() 

 CapSense_EnableWidget()和 CapSense_DisableWidget() 

 CapSense_GetCentroidPos() 

 CapSense_GetRadialCentroidPos() 

 CapSense_GetTouchCentroidPos() 

常量由以下内容组成： 

实例名称 + Widget 名称 + Widget 类型 

例如： 

#define CapSense_UP__BTN        0 

#define CapSense_DOWN__BTN      1 

#define CapSense_VOLUME__SL     2 

#define CapSense_TOUCHPAD__TP   3 
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固件源代码示例  

在 Find Example Project 对话框中，PSoC Creator 提供了大量的示例项目，包括原理图和示例代

码（File > Example Project…）。要获取组件特定的示例，请打开器件目录中的对话框或原理图

中的器件实例。要查看通用示例，请打开“Start Page”或 File 菜单中的对话框。根据要求，可

以通过使用对话框中的 Filter Options 选项来限定可选的项目列表。  

更多信息，请参考《PSoC Creator 帮助》部分中主题为“查找示例项目”中的内容。 

MISRA 合规性 

本节介绍了 MISRA-C:2004 合规性和本组件的偏差情况。定义了下面两种类型的偏差：  

 项目偏差 — 适用于所有 PSoC Creator 器件的偏差  

 特定偏差 — 仅适用于该组件的偏差 

本节介绍了有关组件特定偏差的信息。《系统参考指南》的“MISRA 合规性”章节中介绍了项目

偏差以及有关 MISRA 合规性验证环境的信息。  

CapSense_CSD 组件具有如下特定偏差： 

MISRA-

C:2004规则 

规则类别 

（必须(R)/ 

建议(A)） 

规则说明 违规的辩解 

8.8 R 外部目标或函数只能在一个文件

中声明。 

某些阵列的生成取决于组件的配置情况。在使用

这些阵列的“.c source”文件内对它们进行声明

，并不是在“.h include”文件内进行的。 

11.4 A 指向对象类型的不同指针之间不

应进行转换。 

在组件调谐器助手中，指向组件结构的指针被转

换为8位的数据指针，然后将它们传入到一个用于

传输的I2C API内。由于I2C组件只传输字节流，

因此必须进行该转换。 

17.4 R 数组索引是唯一允许的指针运算

形式。 

该组件具有多个使用指针参数的函数。这些参数

用于传输数据阵列。可以使用数组索引来访问它

们。 

19.7 A 函数应该优先于类似于函数的

宏。 

类函数宏用于提高性能。 
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引脚分配 

CapSense 定制器为每个 CapSense 传感器和支持信号生成一个引脚别名。这些别名用于将传感

器和信号分配到器件上的物理引脚。将 CapSense CSD 组件传感器和信号分配至“设计范围资

源”文件视图“引脚编辑器”选项卡中的引脚。  

传感器引脚 — CapSense_cPort — 引脚分配 

提供别名，使传感器名称与 CapSense 定制器中的 Widget 类型和 Widget 名称相关联。  

传感器别名为： 

Widget 名称 + 元件号 +“__”+ Widget 类型 

CapSense_cCmod_Port — 引脚分配 

外部调制器电容（CMOD）的一侧应连接至物理引脚，另一侧连接至 GND。在 PSoC 4100/PSoC 

4200 器件内，CMOD可以连接至 P4[2]引脚。在 PSoC 4000 器件内，CMOD可以连接至 P0[4]引

脚。CMOD的建议值为 2.2 nF。 

中断服务子程序 

CapSense 组件使用每次传感器扫描结束后触发的中断。您可以在提供的存根子程序中根据需要添

加自己的代码。首次构建项目时，在 CapSense_INT.c 文件中生成存根子程序。您的代码必须添

加在所提供的注释标签之间，在版本间得到保留。 

功能说明 

定义 

传感器 

通过一个引脚连接至 PSoC 的 CapSense 元件。传感器是基材上的一个导电元件。传感器的示例

包括：FR4 上的铜、Flex 上的铜、PET 上的银墨、玻璃上的 ITO。 

扫描时间 

扫描时间是指 CapSense 模块扫描一个或多个电容传感器的一段时间。在给定的扫描传感器中可

以组合多个传感器，以便使能诸如接近传感等模式。 
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CapSense Widget 

CapSense Widget 由一个或多个扫描传感器构成，用于提供较高级别的功能。CapSense Widget

的一些示例包括按键、滑条、辐射滑条、触摸板、矩阵按键和接近传感器。 

手指阈值 

该值用于确定传感器上是否有手指触摸。 

噪声阈值 

用于确定电容扫描中的噪声等级。基准线算法过滤噪声，以便跟踪传感器基准线值中的电压和温

度变化。  

去抖动 

为传感器活动的瞬变增加了去抖动计数器。为了让传感器能够从未激活状态切换为激活状态，在

规定的样本数量内，差异计数值必须大于手指阈值与迟滞之和。这对于滤掉高振幅和频率噪声是

有必要的。  

迟滞 

设置与手指阈值一起使用的迟滞值。如果需要迟滞，传感器不会被视为处于“开启”或“活动”

状态，直至计数值超过手指阈值与迟滞值之和。传感器不会被视为处于“关闭”或“非活动”状

态，直到所测量的计数值降至手指阈值与迟滞值差值以下。 

CapSense 时钟 

PSoC 4100/PSoC 4200 

PSoC 4100/PSoC 4200 器件被链接起来。 下图显示的是 PSoC 4100/PSoC 4200 的 CapSense

时钟树。 

HFCLK 

(IMO or external 

clock)

Clocks for Direct Clock Mode in PSoC 4100/PSoC 4200:

Modulator 

Divider (MD) 

Reg

IMO Clock Analog Switch 

Divider (ASD) 

Reg

Trigger:

F/2

Analog 

Switch Clock 

(SenseClk)

Modulator 

Clock 

(SampleClk)

Modulator Clock = HFCLK/MD

Analog Switch Clock = HFCLK/MD/ASD/2
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HFCLK 

(IMO or external 

clock)

Clocks for PRS Clock Mode in PSoC 4100/PSoC 4200:

Modulator Divider 

(MD) Reg

IMO Clock Analog Switch 

Divider (ASD) Reg
PRS

Analog Switch 

Clock

(SenseClk)

Modulator Clock 

(SampleClk)

Modulator Clock = HFCLK/MD

PRS Maximum Analog Switch Clock = HFCLK/MD/ASD/2

PRS Average Analog Switch Clock = HFCLK/MD/ASD/4  

 

将 IMO 时钟除以调制分频器，就形成了调制时钟。  

将调制时钟除以模拟开关分频器，就形成了感应时钟分频器。 

例如，如果您将模拟开关分频器的值设为 8，且调制器分频器的值设为 4，则将调制器分频器寄存

器配置为除以 4，而且将模拟开关分频器寄存器配置为除以 2。 

PSoC 4000 

PSoC 4000 器件的时钟被链接起来。下图显示的是 PSoC 4000 的 CapSense 时钟树。 

HFCLK (12 MHz)

Clocks for Direct Clock Mode in PSoC 4000:

Modulator Divider 

(MD) Reg

HFCLK Clock Analog Switch 

Divider (ASD) Reg

Trigger:

F/2

Analog Switch 

Clock

(SenseClk)

Modulator Clock

(SampleClk)

Modulator Clock = HFCLK/MD

Analog Switch Clock = HFCLK/ASD/2  
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HFCLK (12 MHz)

Clocks for PRS Clock Mode in PSoC 4000:

Modulator Divider 

(MD) Reg

HFCLK Clock

Analog Switch 

Divider (ASD) Reg
PRS

Analog Switch 

Clock

(SenseClk)

Modulator Clock 

(SampleClk)

Modulator Clock = HFCLK/MD

PRS Maximum Analog Switch Clock = HFCLK/ASD/2

PRS Average Analog Switch Clock = HFCLK/ASD/4  

 

CapSense 模拟系统 

CapSense 模拟系统包括 Sigma Delta 调制器、模拟复用器总线、主 IDAC (IDAC1 – 8 位）和第二

IDAC (IDAC2 – 7 位）。 

在单 IDAC 模式下，补偿 IDAC 在“定制器”通用选项卡上被禁用，以及 CSD 组件仅使用主

IDAC (IDAC1 – 8 位）。在这种情况下，主 IDAC 被配置为由调制器输出控制的变量。  

在基准线 IDAC 模式下，补偿 IDAC 在“定制器”通用选项卡上被禁用，以及 CSD 组件使用两个

IDAC (8 位主 IDAC 和 7 位第二 IDAC）。 

在这种情况下，由于主 IDAC（8 位）被配置为变量 IDAC，所以它被称为调制 IDAC。同样，由于

第二 IDAC（7 位）)被配置为固定 IDAC，所以它被称为“补偿”。 
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Sigma-Delta

Modulator

Vref = 1.2 V

Cmod
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P4 Capsense

CapSense Analog System in Single IDAC mode

 

Sigma-Delta

Modulator

Vref = 1.2 V

Cmod

A
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U
X
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Cs

SW1

SW3

Compensation 

IDAC 

(IDAC2 – 7 bit)

A
n

a
lo

g
 S

w
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C
lo

c
k

P4 Capsense

CapSense Analog System in Split IDAC mode

Modulation IDAC 

(IDAC1 – 8 bit)

 

 

API 分辨率 — 内插和测量  

在滑条传感器和触控板中，通常需要更精确地分辨手指（或其他电容器物体）的位置，而非单个

传感器本身的分辨率。手指触摸滑条传感器或触控板的面积通常大于任何一个传感器。  

为了采用一个质心计算来计算插值后的位置，首先对数组进行扫描以验证所给定的传感器位置是

否有效。要求提供一定数量的相邻传感器信号，且高于噪声阈值。如果发现最强信号，将使用此

信号和大于噪声阈值的相邻连续信号计算触摸中心。使用少至两个、多至八个传感器计算质心。 



PSoC 4 Capacitive Sensing (CapSense® CSD) PSoC
®
 Creator™ Component Datasheet 

页 86/95 Document Number: 001-92183 Rev. **  

CapSense_GetCentroid (CapSense_CalcCentroid) 

function in the PSoC4 (for Linear Slider)

Resolution – API Resolution set in the Customiser,

n – Number of sensor elements in the Customiser.

maximum:  Index of maximum element within centroid.

0 1 2 3 4

Si – different counts (with subtracted Noise Threshold 

value) near by the maximum position:

maximum

Sx+1
Sx-1

Sx0

Example 1:

We have linear centroid of 5 elements with resolution = 100. Noise 

threshold = 2.

CapSense_sensorSignal= [0, 0, 100, 200, 100]. 

maximum = 3;

Then position = ((98-98)/(98+108+98) + 3)*100/(5-1) = 75.

Example 2:

We have linear centroid of 5 elements with resolution = 100. Noise 

threshold = 20.

CapSense_sensorSignal= [0, 10, 100, 210, 180]. 

maximum = 3;

Then position = ((160-80)/(80+190+160) + 3)*100/(5-1) = 79.65 = 80

Rounded

Note1 for Radial Slider:

Sx+1 - Sx-1 
position    =  (

Sx-1 + Sx0 + Sx+1
+ maximum ) * (Resolution / (n-1))

Sx+1 - Sx-1 
position    =  (

Sx-1 + Sx0 + Sx+1
+ maximum ) * (Resolution / n)

Note2 for Radial Slider:

For Radial Slider the algorithm takes to the account the first and last slider 

segments. 

For example if CapSense_sensorSignal= [30, 0, 0, 40, 180] the position in 

the Radial Slider is calculated for x0; x3 and x4 elements. But in the Linear 

Slider the position is calculated for x3 and x4 elements only.   

if position < 0 then

Sx+1 - Sx-1 
position    =  (

Sx-1 + Sx0 + Sx+1
+ maximum  +  n) * (Resolution / n)

position
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计算出的值通常是分数。为了能够采用某一特定分辨率来报告质心（例如对于 12 个传感器使用 0

到 100 的范围），要将质心值乘以标量。另一种更有效的方法是将内插和按比例计算的方法统一

到单一计算中，按所需的量级直接报告结果。这一过程可以在高级 API 内进行处理。滑条传感器

计数和分辨率在 CapSense CSD 定制器中进行设置。  

双工 

在双工滑条中，滑条中的每个 PSoC 传感器连接都会映射到滑条传感器阵列中的两个物理位置

上。物理位置的第一半（较低数值部分）按顺序映射到基部分配的传感器上，端口引脚由设计人

员使用 CapSense 定制器分配。物理传感器位置的另一半（较高数值部分）由定制器中的算法自

动映射，并在包括文件中列出。一旦创建好次序，某一部分中相邻的传感器动作则不会导致另一

部分中相邻的传感器动作。小心地确定此次序，将其映射到印刷电路板上。  

图 1. 双工 

 

应当使滑条中的传感器电容均衡。根据传感器或 PCB 布局，某些传感器对可能需要更长的布线。

当您选择双工时，CapSense 定制器将自动生成双工传感器索引表，列在下方以供参考。  

表 1. 不同滑条段计数的双工序列 

滑条段总计数 段序列 

10 0、1、2、3、4、0、3、1、4、2  

12 0、1、2、3、4、5、0、3、1、4、2、5 
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滑条段总计数 段序列 

14 0、1、2、3、4、5、6、0、3、6、1、4、2、5 

16 0、1、2、3、4、5、6、7、0、3、6、1、4、7、2、5 

18 0、1、2、3、4、5、6、7、8、0、3、6、1、4、7、2、5、8 

20 0、1、2、3、4、5、6、7、8、9、0、3、6、9、1、4、7、2、5、8 

22 0、1、2、3、4、5、6、7、8、9、10、0、3、6、9、1、4、7、10、2、5、8 

24 0、1、2、3、4、5、6、7、8、9、10、11、0、3、6、9、1、4、7、10、2、5、8、11 

26 0、1、2、3、4、5、6、7、8、9、10、11、12、0、3、6、9、12、1、4、7、10、2、5、8、11 

28 0、1、2、3、4、5、6、7、8、9、10、11、12、13、0、3、6、9、12、1、4、7、10、13、2、5

、8、11 

30 0、1、2、3、4、5、6、7、8、9、10、11、12、13、14、0、3、6、9、12、1、4、7、10、13、

2、5、8、11、14 

32 0、1、2、3、4、5、6、7、8、9、10、11、12、13、14、15、0、3、6、9、12、15、1、4、7、

10、13、2、5、8、11、14 

34 0、1、2、3、4、5、6、7、8、9、10、11、12、13、14、15、16、0、3、6、9、12、15、1、4

、7、10、13、16、2、5、8、11、14 

36 0、1、2、3、4、5、6、7、8、9、10、11、12、13、14、15、16、17、0、3、6、9、12、15、1

、4、7、10、13、16、2、5、8、11、14、17 

38 0、1、2、3、4、5、6、7、8、9、10、11、12、13、14、15、16、17、18、0、3、6、9、12、

15、18、1、4、7、10、13、16、2、5、8、11、14、17 

40 0、1、2、3、4、5、6、7、8、9、10、11、12、13、14、15、16、17、18、19、0、3、6、9、

12、15、18、1、4、7、10、13、16、19、2、5、8、11、14、17 

42 0、1、2、3、4、5、6、7、8、9、10、11、12、13、14、15、16、17、18、19、20、0、3、6、

9、12、15、18、1、4、7、10、13、16、19、2、5、8、11、14、17、20 

44 0、1、2、3、4、5、6、7、8、9、10、11、12、13、14、15、16、17、18、19、20、21、0、3

、6、9、12、15、18、21、1、4、7、10、13、16、19、2、5、8、11、14、17、20 

46 0、1、2、3、4、5、6、7、8、9、10、11、12、13、14、15、16、17、18、19、20、21、22、0

、3、6、9、12、15、18、21、1、4、7、10、13、16、19、22、2、5、8、11、14、17、20 

48 0、1、2、3、4、5、6、7、8、9、10、11、12、13、14、15、16、17、18、19、20、21、22、

23、0、3、6、9、12、15、18、21、1、4、7、10、13、16、19、22、2、5、8、11、14、17、

20、23 

50 0、1、2、3、4、5、6、7、8、9、10、11、12、13、14、15、16、17、18、19、20、21、22、

23、24、0、3、6、9、12、15、18、21、24、1、4、7、10、13、16、19、22、2、5、8、11、

14、17、20、23 
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滑条段总计数 段序列 

52 0、1、2、3、4、5、6、7、8、9、10、11、12、13、14、15、16、17、18、19、20、21、22、

23、24、25、0、3、6、9、12、15、18、21、24、1、4、7、10、13、16、19、22、25、2、5、

8、11、14、17、20、23 

54 0、1、2、3、4、5、6、7、8、9、10、11、12、13、14、15、16、17、18、19、20、21、22、

23、24、25、26、0、3、6、9、12、15、18、21、24、1、4、7、10、13、16、19、22、25、2

、5、8、11、14、17、20、23、26 

56 0、1、2、3、4、5、6、7、8、9、10、11、12、13、14、15、16、17、18、19、20、21、22、

23、24、25、26、27、0、3、6、9、12、15、18、21、24、27、1、4、7、10、13、16、19、22

、25、2、5、8、11、14、17、20、23、26 

 

滤波器 

CapSense 组件中提供了几种滤波器：中值、平均值、一阶 IIR 和抖动等滤波器这些滤波器既可与

传感器原始数据结合使用，以降低传感器噪声；也可与滑条和触摸板的位置数据结合使用，以降

低位置噪声。 

中值滤波器 

中值滤波器查看最近三次采样并报告中值。中值是通过整理这三次采样并取中间值来计算的。此

滤波器用于消除短时噪声尖峰并生成一次采样的延迟。由于这种延迟以及 RAM 消耗，通常建议不

要启用该滤波器。启用此滤波器对于每个传感器（原始）和 Widget（位置）会消耗 RAM 的 4 个

字节。默认情况下，该中断被禁用。 

均值滤波器 

平均值滤波器查看位置的最近三次采样并报告简单的平均值。它用于消除短时噪声尖峰并生成一

次采样的延迟。由于这种延迟以及 RAM 消耗，通常建议不要启用该滤波器。启用此滤波器对于每

个传感器（原始）和 Widget（位置）会消耗 RAM 的 4 个字节。默认情况下，该中断被禁用。 

一阶 IIR 滤波器 

一阶 IIR 滤波器是原始滤波器和传感器滤波器建议启用的滤波器，因为它所需的 SRAM 最小并且

响应迅速。IIR 滤波器标度最近的传感器或位置数据，并将其添加到已标度版本的前一个滤波器输

出。启用此滤波器对于每个传感器（原始）和 Widget（位置）会消耗 RAM 的 2 个字节。原始和

位置滤波器在默认情况下启用 IIR1/4。 

一阶 IIR 滤波器：  

current21previous2121IIR   

current41previous4341IIR   
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current81previous8781IIR   

current161previous1615161IIR   

抖动滤波器 

此滤波器可消除在两个值之间切换（抖动）的原始传感器或位置数据中的噪声。如果最近的传感

器值大于上一个传感器值，那么前一个滤波器值将增加 1，反之则会递减。当应用于包含四个或更

少 LSB 峰-峰噪声的数据、或者慢速响应可接受时，这最有效。后者对于某些位置传感器有用。启

用此滤波器对于每个传感器（原始）和 Widget（位置）会消耗 RAM 的两个字节。默认情况下，

该中断被禁用。 

水对 CapSense 系统的影响 

水珠和手指对 CapSense 的影响相似。然而，水珠对传感区整个表面的影响不同于手指的影响。 

水对 CapSense 表面的影响有几种不同形式： 

 器件表面形成的细水流。 

 单独的水珠。 

 当冲洗或浸泡器件时，水流会覆盖器件的全部或大部分表面。  

水含有的盐或矿物使其具有导电性。而且，浓度越高，水的导电性就越强。肥皂水、海水和矿物

质水等液体对 CapSense 有不利影响。这些液体模拟手指触摸器件表面的效果，这可导致传感器

检测出错。 

防水和检测 

此特性可配置 CapSense CSD 组件，以抑制水对 CapSense 系统的影响。此功能设置以下参数： 

 使能屏蔽电极，此电极将用于在硬件层面上补偿水珠对传感器的影响。  

屏蔽电极 

某些应用场合要求即使存在水膜或水珠，也能可靠地运行。白色家电、汽车、各种工业领域和其

他领域应用，都需要使用不会因为水、冰和湿度的变化（会导致凝结）而提供假触发信号的电容

式传感器。在这种情况下可以使用单独的屏蔽电极。此电极位于感应电极之后或其周围。如果器

件丝印层表面有水膜，则屏蔽和感应电极之间的耦合会加剧。屏蔽电极有助于降低寄生电容的影

响，为处理传感电容的变化提供了更具动态性的数值范围。  

在某些应用场合，选择屏蔽电极信号及其相对于感测电极的位置，使由于潮湿所导致两个电极之

间耦合的增大，引起感测电极电容测量值负向触摸变化，这样做很有用。这样可以抑制由于潮湿
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造成的误触，从而简化高级软件 API 的工作。CapSense CSD 组件支持屏蔽电极的单独输出，从

而简化 PCB 布线。 

图 2. 可能的屏蔽电极 PCB 布局 

 

 

图 2 提供了一种按键屏蔽电极的可能布局组态。屏蔽电极尤其适用于透明的 ITO 触摸板器件，在

这种器件中，它不但可阻止 LCD 驱动电极的噪声，同时可减少杂散电容。 

在此示例中，有屏蔽电极板覆盖按键。作为另一替代方法，屏蔽电极可以安装在相对的 PCB 层

上，其中包括按键下面的平板。对于这种情况，建议使用填充模式，填充率约为 30 至 40%。在这

种情况下，无需附加的接地层。 

如果屏蔽电极与感应电极之间出现水珠，“寄生电容”（CPAR）将增加，调制器电流下降。  

屏蔽电极可以连接到任何引脚。将驱动模式设置为慢速强驱动可以降低接地噪声和辐射。另外，

可以在 PSoC 器件与屏蔽电极之间连接上升限制电阻。  

资源 

数字资源： 

配置 
资源类型 

CSD固定模块 中断 

所有配置 1 1 
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模拟资源： 

配置 资源类型 

8位CapSense IDAC 7位CapSense IDAC 

补偿IDAC被禁用 1 0 

补偿IDAC被使能 1 1 

SmartSense 1 1 

 

API 存储器的使用情况 

根据不同的编译器、设备、所用 API 的数量以及组件配置，组件存储器的使用有着显著的不同。

下表列出了在指定组件配置中可用的所有 API 的存储器使用情况。 

使用 Release mode（释放模式）中配置的关联编译器进行了测量，测量中采用了大小的最佳设

置。有关特定的设计，可分析编译器所生成的映射文件以确定内存的使用情况。 

配置 
PSoC 4000 PSoC 4100/PSoC 4200 

闪存字节 SRAM字节 闪存字节 SRAM字节 

Widgets：5个按键 

调校方法：手动 

补偿IDAC：使能 

自动校准：使能 

原始数据滤波器：一阶IIR¼滤波 

BIST：使能 

预充电：PRS_Auto 

单独频率设置：使能 

Widget分辨率：8位 

4008 106 3932 106 

Widgets：55段线性滑条  

调校方法：手动 

补偿IDAC：使能 

自动校准：使能 

原始数据滤波器：一阶IIR¼滤波 

位置噪声滤波器：一阶IIR¼滤波  

BIST：使能 

预充电：PRS_Auto 

单独频率设置：使能 

Widget分辨率：8位 

4050 107 3974 107 
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配置 
PSoC 4000 PSoC 4100/PSoC 4200 

闪存字节 SRAM字节 闪存字节 SRAM字节 

Widgets：5个按键，5段线性滑条  

调校方法：手动 

补偿IDAC：使能 

自动校准：使能 

原始数据滤波器：一阶IIR¼滤波 

位置噪声滤波器：抖动滤波 

BIST：使能 

预充电：PRS_Auto 

单独频率设置：使能 

Widget分辨率：8位 

4506 200 4430 200 

Widgets：4x4矩阵按键 

调校方法：手动 

补偿IDAC：使能 

自动校准：使能 

原始数据滤波器：一阶IIR¼滤波 

BIST：使能 

预充电：PRS_Auto 

单独频率设置：使能 

Widget分辨率：8位 

4024 163 3948 163 

Widgets：8x8触控板 

调校方法：手动 

补偿IDAC：使能 

自动校准：使能 

原始数据滤波器：一阶IIR¼滤波 

位置噪声滤波器：一阶IIR¼滤波  

BIST：使能 

预充电：PRS_Auto 

单独频率设置：使能 

Widget分辨率：8位 

4546 298 4474 298 
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直流和交流的电气特性 

除非另有说明，否则这些规范的适用条件是：-40°C ≤ TA ≤ 85 °C 且 TJ ≤ 100 °C。除非另有说

明，否则这些规范的适用范围为 1.71 V 到 5.5 V。 

直流规范 

参数 说明 最小值 典型值 最大值 单位 条件 

VCSD 工作电压范围 1.71 – 5.5 V  

 

交流规范 

参数 说明 条件 最小值 典型值 最大值 单位 

Cp 传感器电容 具有SmartSense功能 5 – 45 pF 

Cp  SmartSense被禁用 5 – 60 pF 

信噪比 信噪比 在SmartSense调试的所有配置下，
Cp < 35pF 

5    

在SmartSense调试的所有配置下，
35 ≤ Cp ≤ 45pF 

4    

在SmartSense调试的所有配置下，
Cp < 35pF 

5    

在SmartSense调试的所有配置下，
35 ≤ Cp ≤ 45pF 

4    
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组件更改 

版本 更改说明 更改原因/影响 

2.0 添加了PSoC 4000器件的支持。 

更新了调试和扫描算法。 

在对话框中更改调试模式和IDAC的名称 

为参数设置/读取添加了新API。 

添加了BIST支持。 

添加了手动模式的自动校准支持。 

新器件。 

更好的性能。 

增加可用性。 

1.11 更改了多个全局数组的名称及说明，并添加了一些非描述

性全局数组。 

 

添加了MISRA合规性章节。 未证明该组件符合MISRA-C:2004编码准

则。 

1.10 扫描时间得到优化。  

1.0.a 已更新PSoC 4 CapSense设计指南的链接，并对数据手册

进行多处编辑。 

 

1.0 初始版本。  
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